IDA PAPER P-2545

A USER'S GUIDE FOR
THE AVIATION REQUIREMENTS COST
SYSTEM (ARCS)

Paul F. Goree, Project Leader
Joseph S. Domin
Michael C. Frieders
Timothy J. Graves
Bruce R. Harmon
Thomas A. Musson
Terri J. Walsh
Jeffrey B. Tate

January 1991

Prepared for
Office of the Deputy Director Defense Research and Engineering
(Tactical Warfare Programs)

Approved for public release; distribution unlimited.
DEFINITIONS
IDA publishes the following documents to report the results of its work.

Reports
Reports are the most authoritative and most carefully considered products IDA publishes. They normally embody results of major projects which (a) have a direct bearing on decisions affecting major programs, (b) address issues of significant concern to the Executive Branch, the Congress and/or the public, or (c) address issues that have significant economic implications. IDA Reports are reviewed by outside panels of experts to ensure their high quality and relevance to the problems studied, and they are released by the President of IDA.

Group Reports
Group Reports record the findings and results of IDA established working groups and panels composed of senior individuals addressing major issues which otherwise would be the subject of an IDA Report. IDA Group Reports are reviewed by the senior individuals responsible for the project and others as selected by IDA to ensure their high quality and relevance to the problems studied, and are released by the President of IDA.

Papers
Papers, also authoritative and carefully considered products of IDA, address studies that are narrower in scope than those covered in Reports. IDA Papers are reviewed to ensure that they meet the high standards expected of refereed papers in professional journals or formal Agency reports.

Documents
IDA Documents are used for the convenience of the sponsors or the analysts (a) to record substantive work done in quick reaction studies, (b) to record the proceedings of conferences and meetings, (c) to make available preliminary and tentative results of analyses, (d) to record data developed in the course of an investigation, or (e) to forward information that is essentially unanalyzed and unevaluated. The review of IDA Documents is suited to their content and intended use.

The work reported in this document was conducted under contract MDA 903 89 C 0003 for the Department of Defense. The publication of this IDA document does not indicate endorsement by the Department of Defense, nor should the contents be construed as reflecting the official position of that Agency.

This Paper has been reviewed by IDA to assure that it meets high standards of thoroughness, objectivity, and appropriate analytical methodology and that the results, conclusions and recommendations are properly supported by the material presented.
### ABSTRACT (Maximum 200 words)

In order to help DoD analysts assess the structure and cost of military aircraft forces, IDA developed the Aviation Requirements Cost System (ARCS), an integrated system of computer models. This paper provides instructions for use of the five models that make up the ARCS. The Cost Model evaluates the cost consequences of marginal changes in size and composition of DoD aviation forces. The Procurement Model calculates the costs of changes to the procurement profiles for aircraft listed in the Procurement Annex to the Future Years Defense Program (FYDP). The Age Model calculates the average age of an aircraft based on variations in the procurement or retirement plans for that aircraft. The Inventory Model determines the total active aircraft inventory needed to meet program requirements. The New Aircraft Model estimates the acquisition costs of new aircraft based on system design parameters.
A USER'S GUIDE FOR
THE AVIATION REQUIREMENTS COST SYSTEM (ARCS)

Paul F. Goree. *Project Leader*
Joseph S. Domin
Michael C. Frieders
Timothy J. Graves
Bruce R. Harmon
Thomas A. Musson
Terri J. Walsh
Jeffrey B. Tate

January 1991

Approved for public release; distribution unlimited.

IDA
INSTITUTE FOR DEFENSE ANALYSES
Contract MDA 903 89 C 0003
Task T-F7-700
PREFACE

This Document was prepared by the Institute for Defense Analyses (IDA) for the Office of the Director, Defense Research and Engineering (Tactical Warfare Programs), under contract MDA 903 89 C 0003, Task Order T-G7-700, issued 15 March 1989, and amendments. The objective of the task was to improve integration of and access to analytical tools that address aircraft requirements and costs. The results of this task is the Aviation Requirements Cost System (ARCS), an integrated set of five models, for which this Document serves as a guide.

The work was reviewed within IDA by Phillip Gould and Kathryn L. Wilson. Joseph S. Domin one of the authors of this Document, is an IDA consultant.
CONTENTS

Preface .................................................................................................................. iii

I. Introduction ........................................................................................................ 1
   A. Cost Model ................................................................................................. 3
   B. Procurement Model .................................................................................... 5
   C. Age Model .................................................................................................. 5
   D. Inventory Model ........................................................................................ 8
   E. New Aircraft Model .................................................................................... 8

II. The Aviation Requirements Cost System (ARCS) ............................................. 13
   A. Getting Started .......................................................................................... 13
   B. Main Menu Bar .......................................................................................... 13
   C. Using the ARCS ........................................................................................ 17
      1. Preparing the Printer .............................................................................. 17
      2. Purging the Working Directories ........................................................... 17
      3. Selecting Case Files ................................................................................ 19
      4. Preparing Note Cards ............................................................................ 21
      5. Determining the Model Version ............................................................. 21
      6. Using the Excel Menu .......................................................................... 23
      7. Saving a Case .......................................................................................... 23
   D. Exiting ARCS .............................................................................................. 25

III. The Cost Model ................................................................................................ 29
   A. Getting Started .......................................................................................... 29
   B. Menu Bar .................................................................................................... 30
   C. Running the Model ...................................................................................... 33
   D. Exiting the Model ........................................................................................ 45

IV. The Procurement Model .................................................................................. 47
   A. Getting Started .......................................................................................... 47
   B. Menu Bar .................................................................................................... 48
   C. Running the Model ...................................................................................... 50
   D. Exiting the Model ....................................................................................... 54

V. The Age Model .................................................................................................. 57
   A. Getting Started .......................................................................................... 57
   B. Menu Bar .................................................................................................... 58
   C. Running the Model ...................................................................................... 59
   D. Exiting the Model ....................................................................................... 64
VI. The Inventory Model .......................................................... 67
   A. Getting Started .............................................................. 67
   B. Menu Bar ........................................................................ 68
   C. Running the Model ......................................................... 73
   D. Exiting the Model ........................................................... 80

VII. The New Aircraft Model .................................................... 83
   A. Getting Started .............................................................. 83
   B. Menu Bars ....................................................................... 84
      1. New Aircraft Model Menu Bar ....................................... 84
      2. Fighter Aircraft Menu Bar ............................................. 85
   C. Running the Model ......................................................... 88
   D. Exiting the Model ........................................................... 99

Appendix A. System Requirements and Installation Instructions ........ A-1
   System Requirements ................................................................ A-1
   Installation Instructions ....................................................... A-2

Appendix B. ARCS Methodology .................................................. B-1
   Pre-Processors ..................................................................... B-1
   The Cost Model .................................................................... B-1
      Research and Development Costs ...................................... B-2
      Investment Costs ................................................................ B-3
      Operating and Support Costs ........................................... B-5
   Advanced Mission-Oriented Resources Display (AMORD) ........ B-7
   O&S Factors Development ................................................... B-9
   The Procurement Model ...................................................... B-10
      Preparation of the First-Unit Cost and Slope ...................... B-11
   Cost Ratios for Advanced Procurement and Initial Spares .... B-11
   The Age Model .................................................................... B-12
   The Inventory Model .......................................................... B-14
   The New Aircraft Model ...................................................... B-18
      Development Costs ........................................................ B-19
      Production Costs ........................................................... B-20

Appendix C. Directory Structure and File Requirements .................. C-1
   Directory Structure ................................................................ C-1
   File Requirements ............................................................. C-2

Appendix D. AMORD Defense Mission Category Structure ............. D-1
Appendix E. "Get," "Save," and "Purge" Utility Programs................................. E-1
   The Get Program.................................................. E-1
   The Save Program................................................ E-2
   The Purge Program............................................. E-2
Appendix F. Windows Techniques................................................................. F-1
   General Windows Definitions ....................................... F-1
      Keyboard Basics.................................................. F-3
      Mouse Basics.................................................... F-3
   Manipulating Windows............................................... F-3
      Keyboard Manipulation......................................... F-4
      Mouse Manipulation........................................... F-7
   Dialog Boxes and Lists................................................ F-8
      Using the Keyboard with Dialog Boxes.................... F-9
      Using the Mouse with Dialog Boxes....................... F-10
Abbreviations.................................................................................... Abb-1

FIGURES

1. ARCS.......................................................................................... 2
2. Cost Model.................................................................................. 4
3. Procurement Model................................................................... 6
4. Age Model................................................................................. 7
5. Inventory Model ....................................................................... 9
6. New Aircraft Model............................................................... 10
7. ARCS Title Screen................................................................. 14
8. Models Menu Options............................................................ 15
9. Purge Menu Options............................................................... 15
10. ARCS Exit Menu Options........................................................ 16
11. ARCS Help Menu Options....................................................... 16
12. Printer Setup Menu Option...................................................... 17
13. Selecting a Printer................................................................. 18
14. Printer Options...................................................................... 18
15. "Purge Working Directory" Dialog Box.................................. 19
16. "Select Desired Case" Dialog Box......................................... 20
17. Notes and Version Menu Options........................................... 22
18. Example Note Card............................................................... 22
19. Excel Menu Bar Option.......................................................... 23
20. Return to Model Menu Option ................................................................. 24
21. Saving a Case ...................................................................................... 24
22. Windows Program Manager ............................................................... 26
23. Windows File Menu ......................................................................... 26
24. Ending a Windows Session ................................................................. 27
25. Starting the Cost Model .................................................................. 29
26. Cost Model Title Screen .................................................................. 30
27. Selecting Force Files ........................................................................ 33
28. Force File Display ............................................................................ 34
29. Using Paste Force Change Option ...................................................... 34
30. Results of Force Changes .................................................................. 35
31. Set Defaults Option .......................................................................... 36
32. "Cost Model Options" Dialog Box ..................................................... 36
33. Calculating Force Cost Changes ......................................................... 37
34. Cost Tables Option ........................................................................... 38
35. "Select a Cost Table" Dialog Box ....................................................... 38
36. Selecting the Years to be Printed ....................................................... 39
37. Cost Table Display ............................................................................ 40
38. Window Menu Options ...................................................................... 40
39. Selecting the Window to be Viewed .................................................. 41
40. Selecting Chart Option ..................................................................... 42
41. Display of Expanded Chart ................................................................. 42
42. Cost Model Inputs Option .................................................................. 43
43. Selecting an Input File ....................................................................... 43
44. Cost Model Inputs Display ................................................................. 44
45. Print Highlighted Area - Forces Only Option ....................................... 44
46. Cost Model Help Menu Options ......................................................... 45
47. Cost Model Exit Menu Options ......................................................... 46
48. Starting the Procurement Model ......................................................... 47
49. Procurement Model Title Screen ....................................................... 48
50. Procurement Display ......................................................................... 50
51. Calculating Procurement Cost Changes ............................................ 51
52. View Menu Option ........................................................................... 52
53. Delta Case Display ........................................................................... 52
54. Edit/Print Menu Options ................................................................. 53
55. Unit 1 Cost and Slope Display ........................................................... 53
56. Procurement Model Help Menu Options ........................................... 54
57. Procurement Model Exit Menu Options ............................................ 55
58. Starting the Age Model ..................................................................... 57
59. Age Model Title Screen ................................................................... 58

viii
60. Selecting a System Category

61. Selecting Systems

62. Average Age Summary Display

63. Graphs Menu Options

64. Average Age Profile

65. Close Menu Options

66. Age Model Print Menu Options

67. Age Model Help Menu Options

68. Age Model Exit Menu Options

69. Starting the Inventory Model

70. Inventory Model Title Screen

71. Choosing the Select Option

72. Selecting an Inventory File

73. Inventory Model Tables

74. "Adding a New Aircraft" Dialog Box

75. Inventory Menu Options

76. Shortfalls Table

77. Charts Menu Options

78. Inventory Factors Chart

79. Selected A/C Inventory Chart

80. Exiting the Inventory Model

81. Starting the New Aircraft Model

82. New Aircraft Model Title Screen

83. Fighters Option

84. Development Display

85. Mode Menu Options

86. "Select Colors" Window

87. Examples... Option

88. Examples... Display

89. Development Graph Option

90. Development Graph Window

91. Graph Type Option

92. "Graph Type" Dialog Box

93. Development Bar Graph

94. View Graph Data Option

95. Development Graph Data Table

96. Development Parameters Window

97. Production Mode Option

98. Changing Aircraft Production Quantities

99. Production Costs Option

100. Production Costs Option
101. New Aircraft Model Print Menu Options .................................................. 100
102. New Aircraft Model Help Menu Options ................................................ 101
103. Exiting the Fighter Model ...................................................................... 101
104. Exiting the New Aircraft Model ............................................................. 102
B-1. AMORD Matrix ..................................................................................... B-8
B-2. Example of O&M Cost Factor Development ........................................... B-10
C-1. ARCS Directory Structure .................................................................... C-4
F-1. The Windows Program Manager Screen ................................................. F-2
F-2. Microsoft Excel Menu Bar ....................................................................... F-6
F-3. Typical Dialog Box Display ..................................................................... F-8
F-4. Dialog Box Options .............................................................................. F-9

TABLES

A-1. Hardware Requirements for ARCS ......................................................... A-2
A-2. Software Requirements for ARCS .......................................................... A-2
I. INTRODUCTION

The Aviation Requirements Cost System (ARCS) is a series of computer models being developed for the Under Secretary of Defense (Acquisition) (USD(A)) to improve the integration of and access to analytical tools that address force and system costs.

The models that currently make up the ARCS are:

- Cost Model
- Procurement Model
- Age Model
- Inventory Model
- New Aircraft Model.

The ARCS serves as an interface for and an integrator of these models. The user interface and the analyst tools have been developed using Microsoft Windows, Microsoft Excel, and the "C" programming language. The ARCS models have been developed to aid ODDR&E(TWP) when analyzing defense issues as they relate to the structure and cost of the aviation forces. In many cases, the costs associated with the item under investigation are of prime importance when evaluating alternatives. The models included in the ARCS estimate the cost impact of various alternatives or options. A block diagram of the ARCS is shown in Figure 1.

This user's guide provides both general and detailed instructions for operating each of the models in the ARCS. Information is presented in the form of flow diagrams, screen images, menu definitions, and step-by-step examples.

The remainder of this section briefly describes the individual ARCS models and their intended purposes. Section II discusses the ARCS interface and functions that are common to most of the models, while Sections III through VII provide more detailed accounts of how the individual models work. Appendices are provided to cover: system requirements and installation instructions (Appendix A), the methodologies used by each of the ARCS models (Appendix B), directory structure and file lists (Appendix C), the Defense Mission Categories (DMCs) used.
Figure 1. ARCS
to display Department of Defense (DoD) forces (Appendix D), programs unique to ARCS that facilitate saving and retrieving specific cases being analyzed (Appendix E), and general Windows techniques for users new to the Windows environment (Appendix F). Appendix B is particularly important to a thorough understanding of the ARCS. In addition to a technical explanation of how each model works, the appendix lists the key assumptions underlying the models, and details the relationships between the models and their respective data files.

Although the features described here may be modified after the publication of this document, the general techniques used to run the models and view and print the results should remain apparent, even if some of the screen displays change.

A. COST MODEL

The purpose of the Cost Model is to permit you to evaluate quickly the marginal dollar and manpower cost consequences of changes made to DoD aviation forces. Dollar and manpower changes are calculated after changes are made to existing forces. The data for the Cost Model are prepared using pre-processors written by the Institute for Defense Analyses (IDA). Forces data displayed in the model are prepared from the historical data for the years 1980 to the present and from the current Future Years Defense Program (FYDP) for the program period. Forces are extended to FY2010 using data from approved outyear planning documents. Cost data are displayed for FY1989 to FY2010. The FYDP is used for the program period, and cost projections are made based on the assumptions used to extend the forces.

You use the Cost Model by making changes to the force structure and observing the resulting changes to manpower and costs in the Future Years Defense Program. Both current and constant dollar displays are generated for the baseline, delta, and revised versions of the Future Years Defense Program.

Cost and manpower changes calculated by the model are aggregated by military service. Both current and constant dollars can be displayed for the changes made. Additional displays list force changes, procurement quantities, procurement dollars by system, and other information. A block diagram of the Cost Model is in Figure 2.
Figure 2. Cost Model
B. PROCUREMENT MODEL

The Procurement Model allows you to vary the procurement profiles for aircraft shown in the Procurement Annex (PA) and to calculate the costs of changes for the systems, advance procurement, and initial spares. The model mirrors the PA data associated with each Future Years Defense Program and provides a structure that extends to the year 2004 for adding additional aircraft.

The PA is the data source for the Procurement Model. First unit costs and learning curve slopes are calculated from the data shown in the PA by an IDA-developed pre-processor. You make changes by modifying the procurement quantity displayed in a given year. You can also change the first unit cost and the slope of the learning curve used in computing these cost changes. Results show weapon system costs, advanced procurement costs, and the cost of initial spares for each aircraft changed. The total change for each appropriation category is also computed. A block diagram of the Procurement Model is in Figure 3.

C. AGE MODEL

The purpose of the Age Model is to calculate the average age of an aircraft type or a group of aircraft. The model permits you to vary the procurement or retirement plan for an aircraft and to view the resulting average age of the aircraft or group of aircraft to which it belongs. Attrition equations are included in the calculations that produce yearly inventories. The results are presented in tables and graphs for viewing or printing. You are also provided with blank data sets to allow the introduction of new aircraft into the model.

Each aircraft in the Age Model requires a starting point average age, year-end inventory position, and a procurement plan that includes procurement lead time, a retirement plan, and an attrition formula.

You make changes in the Age Model by changing the procurement plan or retirement plan of a given aircraft. Other key factors may also be revised as your analysis requires. Results of the model are average age of the aircraft, average age of the group of aircraft, and graphs of inventory and average age. A block diagram of the Age Model is in Figure 4.
Figure 3. Procurement Model
Figure 4. Age Model
D. INVENTORY MODEL

The Inventory Model allows you to calculate the total active aircraft inventory needed to meet the program requirements. The model permits you to specify (a) the number of aircraft assigned to the various types of wings or squadrons; (b) the number of these wings (or squadrons) required by fiscal year; and (c) the factors that indicate the additional aircraft that are required for training, research and development activities, and the supply pipeline. Tables containing these data are displayed and may be revised. The result of your revisions is shown as a table of the inventory by aircraft type and fiscal year.

The Inventory Model also provides the capability to compare two different aircraft inventory tables to determine the relative shortfalls (or excesses) that exist between the two inventories. Shortfalls can be reexamined as revisions are made to the currently selected inventory file.

The Inventory Model produces 11 different charts that graphically display all of the relevant inventory data. Figure 5 is a block diagram of the Inventory Model.

E. NEW AIRCRAFT MODEL

The New Aircraft Model allows you to estimate the development, procurement, and operating cost of a new aircraft by identifying the key design parameters of that aircraft. For example, the design parameters for fighter aircraft include speed, weight, degree of use of advanced materials, number of engines, complexity of the avionics, and type of the contractual arrangement (i.e., single or multiple contractors).

The model displays the development costs for the new aircraft as parameters are changed. A graph showing costs over time may also be displayed. The calculations for procurement costs and operating and support costs for the new aircraft are displayed in a similar manner. All cost equations for the variables used in the New Aircraft Model were developed by IDA.

Changes in the New Aircraft Model are made by using a mouse to effect changes in the key design parameters and factors displayed by the model. This graphical interface allows you to easily change the parameters and examine the resulting cost changes. A block diagram of the New Aircraft Model is in Figure 6.
Figure 5. Inventory Model
Figure 6. New Aircraft Model
When the model is in the Development Mode, the options on the pull-down menus are as shown in the lighter gray area. The Production Mode options are shown in the darker gray area.
II. THE AVIATION REQUIREMENTS COST SYSTEM (ARCS)

This section describes the features of the ARCS user interface and explains activities that are common to most of the ARCS models. Sections III through VII describe the types of analyses that may be accomplished using different ARCS models.

The instructions in this section assume that ARCS has been installed on your computer and that you are familiar with Windows applications using a mouse. If these conditions are not true, see Appendix A for the ARCS installation instructions and system requirements, and consult your Windows documentation or Appendix F for more information on Windows techniques.

A. GETTING STARTED

At the DOS prompt, change to the drive where ARCS has been installed. Then change to the ARCS subdirectory by typing:

```
CD \ARCS
```

and press the key labeled "ENTER." To start the model, type:

```
ARCS
```

and press ENTER. This action initiates a batch file that calls Windows, Excel, and then ARCS.

B. MAIN MENU BAR

The ARCS title screen and the Main Menu bar are shown in Figure 7. This initial title screen, as well as the title screen for each ARCS model, displays a message in the bottom left-hand corner indicating the first action to be taken to execute a model. In this case, the message is "Select a Model to Begin."
Before choosing a model, look across the Main Menu bar to see the pull-down menus available. The Main Menu bar offers the following four pull-down menus:

- **Models** provides both a list of the five models available in the ARCS and an opportunity to set up a printer for use with the models (Figure 8). The options are:
  - **Cost Model**
  - **Procurement**
  - **Age**
  - **Inventory**
  - **New Aircraft**
  - **Printer Setup.**

- **Purge** provides the option of deleting files from the working directories associated with four of the models in the ARCS. The pull-down menu consists of a list of these four models (Figure 9). The Inventory Model does not use the working subdirectory approach and therefore is not listed on the **Purge** menu. Inventory files may be purged using a menu option within the Inventory Model.
- **Exit** (Figure 10)
  - To **Windows** closes the ARCS, and provides access to Windows.
- **Help** provides a pull-down menu for access to on-line information regarding the menu choices (Figure 11). You may also access the on-
line help by pressing the Help Function Key, F1, when any menu item is highlighted or any dialog box is displayed. The Help pull-down menu also provides access to Version information about the ARCS models.

Figure 10. ARCS Exit Menu Options

Figure 11. ARCS Help Menu Options
C. USING THE ARCS

1. Preparing the Printer

Printer Setup is an option on one of the pull-down menus of each ARCS model. It is also an option under Models on the ARCS Main Menu (Figure 12). When this option is selected, a dialog box is displayed containing a list of the printers available and their respective ports (Figure 13). Highlight the appropriate printer and click on "Setup . . .".

![Figure 12. Printer Setup Menu Option](image)

The next dialog box, whose title is the same as the printer chosen from the previous dialog box, displays a variety of printing options (Figure 14). Choices made in this dialog box depend on your specific printer and desires.

After making the desired printer setup changes, click on "OK," which returns you to the printer list dialog box described above. Click on "OK" in this dialog box, and you will be returned to the Main Menu or to the model from which you began.

2. Purging the Working Directories

The ARCS Main Menu also provides the capability to purge certain files from the ARCS working directories. During normal use of the Cost, Procurement,
Figure 13. Selecting a Printer

Figure 14. Printing Options
Age, and New Aircraft Models within ARCS, files are loaded from the baseline or other subdirectories into the working directory of the particular model. When you exit one of these models, these files are retained for use the next time the model is used, i.e., as the "previous case." If, however, you need to reduce the amount of disk space that ARCS is using, you have the option of deleting selected or all files from the working directories of the individual models. The Purge pull-down menu lists four of the models in ARCS (Figure 9). From the pull-down menu, select the model to be purged. After the selection, a dialog box entitled "Purge Working Directory" appears from which you may select individual files to be deleted (Figure 15).

![Figure 15. 'Purge Working Directory' Dialog Box](image)

Select the file to be deleted by highlighting it in the list box and clicking on "Delete highlighted file." To delete all files in the working directory, click on "Delete all files." Click on "Finished" when you are done deleting files.

3. Selecting Case Files

We will use the Cost Model as an example of how to enter one of the ARCS models. Select Cost Model from the Models pull-down menu. Since we have selected a model other than the Inventory Model, the "Select Desired Case" dialog box shown in Figure 16 appears. This box prompts you to select the baseline case, select a previously saved case, to resume work on a scenario that currently resides in
the working directory (i.e., the "previous case"), to delete a previously saved case, or to cancel the model selection and return to the ARCS Main Menu. When a model is initiated, one or more subdirectories contain the files required to execute that model, for a given set of conditions. For example, if the model selected was used previously for an exercise and the results were saved, they could be recalled to begin at the same position. Of course, new exercises can be initiated by resetting to the baseline position. A separate working directory is used for all model calculations. (See Appendix C for a display of the ARCS directory and file structure.)

![Figure 16. "Select Desired Case" Dialog Box](image)

The dialog box contains the following choices:

- "Get highlighted case" loads the highlighted case into the working directory. First highlight the desired case in the list box and then click on the command button. There will be a delay as the appropriate files are copied from the chosen case's directory into the working directory (the presence of the hour glass symbol means the computer is working and you must wait before initiating the next action).

- "Use previous case" uses the case in the working directory from the most recent run of the model.

- "Delete highlighted case" deletes a case that was previously saved. First highlight the case to be deleted and then click on the command button.
• "Cancel" cancels the model selection you have made and returns you to the ARCS Main Menu.

Note that "Baseline" must be chosen for the first run of each model after installation. "Baseline" should also be chosen when the files in the working directory should be reset to the base case before running the model again. Other case names in the list box are the names of the directories that contain the files generated and saved in previous runs of the model. One of these case names should be chosen when further analysis is to be done using the results from a previous exercise.

The selected model's title screen and menu bar will appear after choosing either of the first two options in the "Select Desired Case" dialog box.

4. Preparing Note Cards

On the Help menu of each model, there is a Notes option (Figure 17). Notes provides you with access to the Windows "note card" feature. Note cards may be used to list assumptions made in a particular case or run of the model, changes made to input parameter lists, or the purpose of the particular analysis. Figure 18 shows an example note card. For best performance you should always invoke the note card feature from the pull-down menu. Do not close or minimize the note card window unless you are sure you will have no further need for it during the current run of the model. Following each use of the note cards, just click on any part of the screen outside the note card window (such as the model menu bar) to hide the note card window and return control to ARCS. Upon exit from any ARCS model you will be prompted to save or close an open note card file. Once saved, the note card becomes part of the case that is being run and will be saved with the case working files. During use of the case files, the note cards are available for viewing or editing to maintain a description of the case.

5. Determining the Model Version

One of the options on the Help pull-down menus of the ARCS Main Menu and each model's menu bar is Version (under Notes in Figure 17). By selecting this option, you can display descriptive information about the current version of the ARCS or the individual model, including a summary of changes since the prior version. Version information for the Cost, Age, and Procurement models will also specify the source of the current baseline data.
For HELP with Notes, press F1.

Figure 17. Notes and Version Menu Options

Figure 18. Example Note Card
6. Using the Excel Menu

One of the options on the Exit pull-down menu of each model's menu bar is Excel Menu Bar (Figure 19). You can use this option to replace the model's menu bar with the Excel menu bar, thereby gaining access to the full capability of Excel. Only an experienced Excel user should exercise this option. By using the Excel menus it is possible to leave the model's files in an unknown state relative to the model. It is always best to use the model's menus when dealing with model related files. To return to the model's menu bar from Excel, select the last item on the Excel File menu, Return to Model Menu (Figure 20). Assuming that no other processing has taken place, this selection restores the appropriate model menu bar, and analysis may proceed as if uninterrupted.

![Figure 19. Excel Menu Bar Option](image)

7. Saving a Case

Each model's menu bar provides an Exit pull-down menu with the option To ARCS (above Excel Menu Bar in Figure 19). After you select this option from any one of the model's menu bar (except that of the Inventory Model), a dialog box appears entitled "Select Existing Case or Create New Case" (Figure 21). This dialog box prompts you to save the changes and outputs of the current run. The save
Return to the Active Model's Menu Bar

**Figure 20. Return to Model Menu Option**

![Figure 20. Return to Model Menu Option](image)

**Figure 21. Saving a Case**

![Figure 21. Saving a Case](image)
function creates a directory, using the name provided, and saves the files that are necessary to reestablish the position that was generated by the current exercise of the model. These case names appear in the "Select Desired Case" dialog box (see subsection IIIC3) in subsequent runs of the model. The results of any run of a model should be saved if they might be needed at a later time.

As mentioned previously, the Inventory Model operates differently. See section VI for specific information about saving a case in the Inventory Model.

To continue, take one of the following actions:

- Type a name (no more than eight alphanumeric characters with NO spaces) into the "New case" text box and choose either "Save - No Exit" or "Save - Exit." (You are prevented from using the word "Baseline" as a name to prevent overwriting of the baseline position.) This action creates a new subdirectory containing copies of necessary files from the working directory. The original files remain in the working directory until another case is selected.

- Highlight an existing case in the list box and choose "Save - No Exit" or "Save - Exit." This action copies necessary files from the working directory into the existing directory that you have selected, overwriting any files already saved there with the same name. The original files will remain in the working directory until another case is selected.

- Choose either "No Save - No Exit" or "No Save - Exit" if you do not wish to save the files in the working directory into a separate directory. The files will remain in the working directory until another case is selected.

D. EXITING ARCS

To exit the ARCS from the Main Menu, select Exit and choose To Windows. A separately initiated exit from Windows is required to return to MS-DOS. For example, if you choose To Windows, the Windows Program Manager appears (Figure 22). Choose the File pull-down menu from the Windows menu bar (Figure 23) and choose Exit Windows.

To leave Windows and return to the DOS prompt, respond to the "Exit Windows" dialog box that appears (Figure 24) by clicking on "OK."
Figure 22. Windows Program Manager

Figure 23. Windows File Menu
Figure 24. Ending a Windows Session
III. THE COST MODEL

The Cost Model provides a means to quickly evaluate the marginal cost and manpower consequences of changes made to DoD Aviation Forces.

A. GETTING STARTED

To begin the Cost Model, choose the Models pull-down menu from the ARCS Main Menu and choose the Cost Model option (Figure 25).

The dialog box entitled "Select Desired Case" appears. The use of this dialog box is described in more detail in subsection IIC3. Select the desired case. Once a case has been selected, the initial Cost Model title screen with menu bar appears on the screen (Figure 26).
B. MENU BAR

The Cost Model menu bar offers the following eight pull-down menus:

- **Window** (Note that this menu is available only after a force file has been selected.)
  - *Select a window* presents a dialog box with a list of the currently open files. Selecting one of the files from this list will cause the window for that file to be brought to the foreground.
  - *Close a window* presents a dialog box with a list of the currently open files. Selecting one of the files from this list will cause that file to be closed.

- **Select**
  - *Return to Base Case* resets the active force file to the baseline. This option will only return the currently selected forces (Air Force or Navy) to the baseline position. For information on resetting all force files to the baseline, see *Get Case* below.
  - *Save Force Changes* allows you to save the active force file from the current run, at any time during the run, and to continue with additional changes. Subsection IIC7 and Appendix E explain the save feature in more detail.
- **Print Highlighted Area - Forces Only** allows you to print a selected area of a file. This option applies only to force files.

- **Get Case** reactivates the "Select Desired Case" dialog box detailed in subsection IIC3. The files in the working directory will be replaced by the files from the selected case.

- **Prepare New Input Data** creates updated baseline Cost Model files from pre-processed inputs created each time the Future Years Defense Program is updated.

- Below the horizontal line in the **Select** menu is a list of the force files that can be examined and changed.

- **Calculate**
  - **Now...** begins execution of the Cost Model calculations.
  - **Set Defaults** allows you to select the default settings for the calculations. These settings determine the costs (e.g., R&D, procurement, O&S) that will be calculated.

- **View**
  - **Cost Tables** allows you to view the cost tables. The baseline cost tables may be viewed at any time; however, revised and delta costs will only be present after using the **Now...** option on the **Calculate** pull-down menu. You have the option of viewing the tables in constant or FYDP (current) dollars. This list box also contains the modifications, replenishment spares, and support equipment and facilities (MRS) cost tables.
  - **Manpower Tables** provides access to the manpower output tables. The options are similar to those for the **Cost Tables** option except the results are associated with manpower changes.
  - **Other Tables** allows you to view other output tables (e.g., force changes or procurement dollars by system). These tables are only available after using the **Now...** option on the **Calculate** pull-down menu.
  - **Printer Setup** allows you to select printer settings. See subsection IIC1 for additional information.

- **Edit**
  - **Paste Force Change** saves time and avoids mistakes when entering a force change over several years. Begin by selecting the area to be
changed. Then choose the **Paste Force Change** option to display a dialog box that prompts for the quantity change (a positive or negative number is permitted).

- **Cost Model Inputs** displays a dialog box with the names of the files that can be edited. Most cost model input files are readily available for viewing and editing. If changes are made that should be used by the model for subsequent calculations, be sure to save the changes (see below). When input files are changed and used for subsequent calculations, they will be saved with other files during the save case routine initiated when returning to the ARCS Main Menu.

- **Parametric Characteristics** displays the characteristics used for the parametric O&S calculation. These files may be edited, saved, and used in subsequent runs.

- **Save Changes** saves the changes made to a cost model input file or a parametric characteristics file. *The file to be saved must be the active window.*

- **Chart**
  - **Zoom Selected Chart** fills the screen with the selected chart, and replaces itself with the **Restore** option.
  - **Restore** returns a zoomed chart to its original size and position, and replaces itself with the **Zoom Selected Chart** option.
  - **Close Selected Chart** closes the window of the selected chart.

- **Exit**
  - **To ARCS** closes all files, initiates the save case routine detailed in subsection IIC7, and returns you to the ARCS Main Menu.
  - **Excel Menu Bar** provides full access to Microsoft Excel by replacing the model's menu bar with the Excel menu bar. To return to the Cost Model menu bar, select the **File** pull-down menu from the Excel menu bar and choose **Return to Model Menu**. See subsection IIC6 for important additional information concerning this procedure.

- **Help** provides a pull-down menu for access to on-line information about the menu bar choices. You may also access the on-line help by pressing the **Help Function Key**, F1, when any menu option is highlighted or any dialog box is displayed. The **Help** menu also provides the **Notes** option that allows you to make notes about the current run of the model. See
subsection II.C4 for additional information about note cards. The Help menu also provides the Version option, which displays the version information about the Cost Model, including a summary of changes since the prior version.

When the model is first started, some of the menu options are disabled or "grayed" to indicate that they are not "active" (available for use). They will become active later during the execution of the model.

C. RUNNING THE MODEL

To show how the model operates, the category of Navy aircraft will be used as an example. To select this category, choose Select from the menu bar, and select Navy from the resulting pull-down menu (Figure 27).

As the files are being read, a message box appears that states the model is "Reading the NAVY Force file." The next display seen is the force file (Figure 28). This screen displays the Defense Mission Category (DMC) title, the Resource Identification Code (RIC) title, and 8 of the 31 years of force quantity data (1980-2010). Scroll through the file by using the scroll bars or the arrow keys, or by using the mouse to click on a specific location.
The primary function of this display is to change force levels. As an example, choose AV-8B and add 20 aircraft to the years 1993 to 1998. This can be done by using the Paste Force Change option from the Edit menu as shown in Figure 29.
You can enter either an absolute quantity that will replace the existing value or a quantity (positive or negative) that will be added to the existing value. Make any other desired force change. The result of the changes are shown as illustrated in Figure 30.

![Figure 30. Results of Force Changes](image)

Once all changes have been made, choose **Calculate** on the menu bar and select the **Set Defaults** option (Figure 31) to display the "Cost Model Options" dialog box (Figure 32).

This dialog box allows you to select the calculations the Cost Model will make. For this example, select all of the options, "R&D," "Procurement," "Parametric O&S," "Manpower," and "Create MRS Output Report." When an option is omitted, the costs for that option will not be calculated or displayed when cost tables are viewed. The options you select are used for subsequent runs unless you reset to another case or change the options again. For the "Factor O&S" calculation (which is always selected), several alternative cost factors are derived from the Future Years Defense Program (FYDP). You can select from the three options to determine which factors will be used when the model calculates. The three options for Program Years are "Year by Year" (FY93 data is used for FY93 factors, and so on), "Average" (the first four non-zero years in the FYDP are
Figure 31. Set Defaults Option

Figure 32. "Cost Model Options" Dialog Box

36
averaged), or "Olympic Average" (all non-zero values minus the highest and lowest values are averaged). For Extended Years, "Year by Year" is replaced with "Straightline Last Year." For this example, select "Year by Year" for the Program Years and "Average" for the Extended Years.

To initiate the calculations, select the Now.. option from the Calculate menu (Figure 33).

![Figure 33. Calculating Force Cost Changes](image)

When the calculations are initiated, a small window appears on the screen with a row of little black boxes indicating that the model is running. These boxes will progressively disappear as each step of the calculation is completed. When the model has completed its calculations, control of the model is returned to you so that results may be viewed or other changes initiated.

To examine the model's output, select View from the menu bar (Figure 34). The options on this menu are Cost Tables, Manpower Tables, Other Tables, and Printer Setup. Choose Cost Tables. A dialog box entitled "Select a Cost Table" appears on the screen (Figure 35). Several choices must be made on this screen in order to get the desired results. Scroll through the list box and select "Navy" by highlighting the title with the cursor. Now choose either the "Delta," "Base," or
### Figure 34. Cost Tables Option

<table>
<thead>
<tr>
<th>DMC TIN RC TIN</th>
<th>FY92</th>
<th>FY93</th>
<th>FY94</th>
<th>FY95</th>
<th>FY96</th>
<th>FY97</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1 To A14 (M)</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>A2 To A14 (M)</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>A3 To A14 (M)</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>A4 To A14 (M)</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>A5 To A14 (M)</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>A6 To A14 (M)</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
</tr>
</tbody>
</table>

For HELP with Cost Tables, press F1

### Figure 35. *Select a Cost Table* Dialog Box
"Revised" case and choose either "Constant" or "FYDP" dollars. Multiple outputs can be viewed, but Excel has a limit of 13 open windows at any one time. The options to create a graph and print the selected table are also presented in this dialog box.

Choose "Delta" for the case and "Constant" for the dollars to view the cost table for the run just completed. The cost table displays the direct and indirect costs for R&D, Investment, and O&S. A separate O&S calculation using parametric methods is also displayed at the bottom of each service's table. See the Cost Model section of Appendix B for definitions of the costs in the output table and a complete explanation of how they are derived.

Select "Print" by clicking on the "Print" check box. If the "Print" check box is selected, a subsequent dialog box will allow you to select the range of years to be printed. Select "1990" as the first year and "1995" as the last year to be printed (Figure 36). The results of the model's calculations are shown in the selected table (Figure 37).

![Figure 36. Selecting the Years to be Printed](image)

The **Window** pull-down menu provides two options to assist in managing multiple open windows (Figure 38). **Select a Window** allows you to bring any open window to the foreground. **Close a Window** allows you to close any of the open
windows. Select the **Select a Window** option from the **Window** menu. A dialog box is displayed with a list of the open windows (Figure 39). Select "NV Direct $ (D) (Chart)" to view the chart of Navy direct costs.

![Figure 37. Cost Table Display](image)

![Figure 38. Window Menu Options](image)
The "Select a Cost Table" dialog box (Figure 35), presents the option to graph the data in the selected table. If this option is checked, graphical charts of the cost data are displayed along with the cost table (Figure 40). The Chart menu provides limited control of these charts. Select one of the charts by clicking on the chart window. Then select **Zoom Selected Chart.** The chart will zoom to fill the screen (Figure 41). Selecting **Restore** from the Chart menu will return the chart window to its original size and position. Use **Close Selected Chart** to close the selected chart.

Both the cost model input files and the parametric characteristics files are available for you to review or edit. Edited factors are used by the model for subsequent runs until a different case is selected using the **Get Case** option from the Select pull-down menu. Select the **Edit** pull-down menu, and select **Cost Model Inputs** (Figure 42).

A dialog box appears with a list of the available files. Select "O&S Factors (T) TAC NAVY" (Figure 43). This file contains the O&S cost factors for the total costs associated with the Navy tactical aviation forces. The file is displayed as shown in Figure 44.
Figure 40. Selecting Chart Option

Figure 41. Display of Expanded Chart

42
To print a portion of the forces table, return to the forces window using the Select a Window option described previously. Using the mouse or arrow keys, select the forces (quantities only) you want to print. Then, using the Select pull-down menu, choose Print Highlighted Area - Forces Only (Figure 45). The correct titles will be provided automatically.
If at any time during the use of the model explanations of options or choices are desired, help is available. Selecting Help from the menu bar provides a pull-down menu that allows you to access on-line information about the menu options (Figure 46). You may also access the on-line help by pressing the Help Function Key, F1, when any menu item is highlighted or any dialog box is displayed. The Help menu also provides the Notes and Version options that allow you to attach case-specific note cards to the current run and to view information describing the current version of the Cost Model.

![Figure 46. Cost Model Help Menu Options](image)

**D. EXITING THE MODEL**

To exit from the Cost Model, choose Exit from the menu bar and To ARCS from the pull-down menu (Figure 47). A dialog box appears and the options for saving the current run are presented. See subsection IIC7 for a detailed description of the save function. To return to the ARCS Main Menu, choose "Save - Exit" or "No Save - Exit." You may also remain in the Cost Model by selecting "Save - No Exit" or "No Save - No Exit."
Figure 47. Cost Model Exit Menu Options
IV. THE PROCUREMENT MODEL

The Procurement Model provides access to systems and their costs as they appear in the Procurement Annex (PA). Calculations are made to establish a pseudo-first-unit cost and slope for subsequent analytical calculations.

A. GETTING STARTED

To begin the Procurement Model, choose the Models pull-down menu from the ARCS Main Menu and choose the Procurement option (Figure 48).

The dialog box entitled "Select Desired Case" appears. The use of this dialog box is described in more detail in subsection IIC3. Select the desired option. Once a case has been selected, the Procurement Model title screen appears (Figure 49).
B. MENU BAR

The Procurement Model menu bar offers the following six pull-down menus:

- **Category** provides two options, Navy Aircraft or USAF Aircraft. Choosing one of them causes the cost and quantity data from that part of the Procurement Annex to be loaded into the baseline spreadsheet of the Procurement Model.

- **Process**
  - **Calculate Changes Now** recalculates all spreadsheet values. Use this option after all changes have been made, or when you want to see the results of any changes made.
  - **Prepare New Input Data** creates updated baseline procurement files from pre-processed inputs created each time the Future Years Defense Program is updated.
  - **Select New Category** is used to select a different category for analysis.
  - **Return to Base Case** resets the selected category to the baseline position.

- **View**
  - **Base Case** is the baseline from the Procurement Annex. This position can be viewed, but no changes are possible.
- **Revised Case** is the work area where all procurement changes are made.

- **Delta Case** displays the changes that are made in the revised case work area.

- **Edit/Print**
  - **Edit Unit 1 Cost and Slope** displays a spreadsheet of these data that can be edited and then used in subsequent calculations.
  - **Print Highlighted Area** allows selected data to be printed. Titles are provided automatically.
  - **Print Output** prints a report that reflects all changes made during the current exercise.
  - **Printer Setup** activates a dialog box for setting up the printer. See subsection IIC1 for further information on printer setup.

- **Exit**
  - **To ARCS** closes all files, initiates the save case routine detailed in subsection IIC7, and returns you to the ARCS Main Menu.
  - **Excel Menu Bar** provides full access to Microsoft Excel by replacing the model's menu bar with the Excel menu bar. To return to the Procurement Model menu bar, select the File pull-down menu from the Excel menu bar and choose **Return to Model Menu**. See subsection IIC6 for important additional information concerning this procedure.

- **Help** provides a pull-down menu allowing you to access on-line information about each menu bar option. You may also access the on-line help by pressing the Help Function Key, F1, when any menu option is highlighted or any dialog box is displayed. The **Help** menu also provides the **Notes** option that allows you to attach case-specific note cards to the current run. See subsection IIC4 for additional information about note cards. The **Help** menu also provides the **Version** option, which displays version information about the Procurement Model, including a summary of changes since the prior version.

When the model is first started, some of the menu bar options are disabled or "grayed" to indicate that they are not "active" (available for use). They will be active later during the execution of the model.
C. RUNNING THE MODEL

To show how the model operates, the category of Navy aircraft will be used as an example. Choose Category from the Procurement Model menu bar. Select Navy Aircraft from the pull-down menu.

The spreadsheet that appears (Figure 50) displays the procurement data for Navy aircraft and includes the funding profiles and quantities for the fiscal years 1989 to 1997. The spreadsheet structure is extended through year 2004 to accommodate the addition of new funding profiles and quantities. Changes can be made to any quantity in the quantity columns. Changes may also be made to the dollar amounts for modification, replenishment spares, and support equipment that appear at the bottom of the category. The quantity columns alternate with the budget year dollars (BY$) columns. The line entitled "Change in Appropriation ($M)" shows the sum of all the changes to both cost and quantity that are made in the course of running the model. The line entitled "Appropriations Total ($M)" shows the revised appropriations total that incorporates all changes.

Move to the quantity column for FY91 and the row for the AV-8B. Change the quantity to 35. After pressing ENTER, you will see changes to the weapon system cost, the advance procurement costs for the current year and the prior year,
and the initial spares cost. All subsequent year data will also change as each procurement is moved along the calculated learning curve.

After you have selected a category and made changes to the worksheet, recalculate all entries by choosing the **Calculate Changes Now** option on the Process menu (Figure 51) or by pressing the F9 Function Key.

![Figure 51. Calculating Procurement Cost Changes](image)

The next menu on the menu bar is **View**, which allows you to display one of the three areas on the spreadsheet (Figure 52). The **Revised Case** option allows editing of the spreadsheet and is always displayed when a category is first selected. The **Base Case** option displays the baseline values for viewing only; editing is not available. The **Delta Case** option displays the delta values (revised case minus base case). Although the delta values cannot be edited, they reflect any changes entered using the **Revised Case** option.

Choose **View** from the Procurement Model menu bar, and select **Delta Case** from the pull-down menu. The column and row headings in this display (Figure 53) are identical to those of the previous display; however, the data shown here summarize the changes that have been made. (Note the "11" indicating the quantity change from 24 to 35.)

---

51
Choose **View** again and then select **Revised Case**. This action returns you to the procurement display screen for making additional changes.

Now choose **Edit/Print** from the menu bar. Select **Edit Unit 1 Cost and Slope** from the resulting pull-down menu (Figure 54).
A new spreadsheet is displayed (Figure 55) with columns titled "Q1_Cost" and "Slope." The values presented in this spreadsheet were calculated in the Procurement Pre-Processor. Here, however, you can make changes if desired. If changes are made to the first-unit cost and/or slope values, subsequent calculations are performed using the new values.
If Help is chosen from the menu bar, on-line information about each of the choices on the menu bar can be accessed (Figure 56). You may also access the on-line help by pressing the Help Function Key, F1, when any menu option is highlighted or any dialog box is displayed. The Help menu also provides the Notes and Version options that allow you to attach case-specific note cards to the current run of the model and to view information describing the current version of the Procurement Model.

![Figure 56. Procurement Model Help Menu Options](image)

D. EXITING THE MODEL

To leave the Procurement Model, choose Exit from the menu bar. Then choose To ARCS from the resulting pull-down menu (Figure 57). A dialog box prompts you to save the current spreadsheet before exiting. A second dialog box presents options for saving the current run under an existing case name or under a new case name. See subsection II.C7 for a detailed description of the save function. To return to the ARCS Main Menu, choose "Save - Exit" or "No Save - Exit." You may also return to the Procurement Model by selecting "Save - No Exit" or "No Save - No Exit."
Figure 57. Procurement Model Exit Menu Options
V. THE AGE MODEL

The Age Model provides a means to calculate the average age of a system (i.e., an aircraft type) or a group of systems.

A. GETTING STARTED

To begin the Age Model, choose the Models pull-down menu from the ARCS Main Menu and choose the Age option (Figure 58).

![Figure 58. Starting the Age Model](image)

The dialog box entitled "Select Desired Case" appears. The use of this dialog box is described in more detail in subsection IIC3. Select the desired case. Once a case has been selected, the Age Model title screen appears (Figure 59).
B. MENU BAR

The Age Model menu bar offers the following six pull-down menus:

- **Select System**
  - Choose Category is used to select a single service's aircraft for further analysis using the Age Model.
  - Choose Specific System is used to select a specific aircraft from a list of all aircraft in the chosen category.
  - Change Included Systems allows the list of aircraft types selected from the chosen category to be revised.

- **Close**
  - Category Display closes the displays for the current category.
  - Specific System Window closes the window for the specific system, and activates the category display.

- **Print**
  - Selected Area prints the selected area from the active window.
  - Graph prints the graph that is currently selected.
  - Printer Setup activates a dialog box for setting up the printer. See subsection IIIC1 for additional information on printer setup.
- **Graphs**
  - **Show Inventory** displays the inventory graph. Individual systems are displayed cumulatively in an area format.
  - **Show Average Age** displays a graph of average age of the selected aircraft.
  - **Close Inventory Graph** closes the inventory graph.
  - **Close Average Age Graph** closes the average age graph.

- **Exit**
  - **To ARCS** closes all files, initiates the save case function detailed in subsection IIC7, and returns you to the ARCS Main Menu.
  - **Excel Menu Bar** provides full access to Microsoft Excel by replacing the model's menu bar with the Excel menu bar. To return to the Age Model menu bar, select the File pull-down menu from the Excel menu bar and choose **Return to Model Menu**. See subsection IIC6 for important additional information concerning this procedure.

- **Help** provides a pull-down menu allowing you to access on-line information about each menu bar option. You may also access the on-line help by pressing the Help Function Key, F1, when any menu option is highlighted or any dialog box is displayed. The **Help menu** provides the **Notes** option that allows you to attach case-specific note cards to the current run of the model. See subsection IIC4 for additional information about note cards. The **Help menu** also provides the **Version** option, which displays version information about the Age Model, including a summary of changes since the prior version.

When the model is first started, some of the menu options are disabled or "grayed" to indicate that they are not "active" (available for use). They will become active later in the execution of the model.

**C. RUNNING THE MODEL**

To show how the model operates, the category of Air Force bombers will be used as an example.

In order to choose the systems to be reviewed, choose **Select System** from the Age Model menu bar. Select **Choose Category** from the pull-down menu. A dialog
box appears containing a list of the categories that have systems with age information (Figure 60). Choose the category "AF Bomber."

![Microsoft Excel - AGE.XLC](image)

**Figure 60. Selecting a System Category**

After you select the category, a dialog box appears with a check list of all of the systems included in the selected category, in this case Air Force bombers (Figure 61). Only those systems that are checked will be included in the overall average age figures. These systems will also be the only ones for which an individual average age will be shown on the summary table and graphs. For this example, choose the aircraft "B-52" and "B-1" by clicking in the appropriate boxes.

The category window (Figure 62) displays the overall average age for the years 1987 to 2005 for the selected systems, as well as the individual average age for each of those systems, in this case the B-52 and B-1.

At this point in the execution of the Age Model, most menu bar options are activated. Click on the options to view each of the resulting pull-down menus.

Now choose **Graphs** from the menu bar. The pull-down menu has four options (Figure 63). Choose **Show Inventory** to display an area graph of the Air Force Bomber/Tanker Inventory for the selected systems. Choose **Graphs** again, followed by the choice of **Show Average Age** to display a bar graph showing the overall average age by year for the selected systems.
Figure 61. Selecting Systems

Figure 62. Average Age Summary Display
To see a more complete profile for a specific system, re-choose the Select System option from the menu bar. Then select Choose Specific System from the resulting pull-down menu. A list box appears that shows the systems included in the category "AF Bomber." Select "B-52."

The specific system window (Figure 64) displays the age profile of the B-52. It is on this display that changes to the procurement or the retirement profile can be made. Move to the year 1992 and retire 15 aircraft by typing "15" in the appropriate cell and pressing ENTER. The model recalculates all affected values and redraws the graphs displayed behind the specific system window. Click on either of the graphs to bring it to the foreground for better viewing. Click on the specific system window to return it to the foreground.

To close the graphs, choose Graphs from the menu bar and then Close Inventory Graph. Choose Graphs again and then Close Average Age Graph.

In order to choose different systems or select a different category, it is necessary to close the specific system window. Choose Close from the menu bar (Figure 65) and then choose Specific System Window from the menu. The category window will be redisplayed. Choose Close again, and select Category Display.
### Figure 64. Average Age Profile

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B-52</td>
<td>10.5</td>
<td>12.5</td>
<td>14.5</td>
<td>16.5</td>
<td>18.5</td>
<td>20.5</td>
<td>22.5</td>
<td>24.5</td>
<td>26.5</td>
</tr>
<tr>
<td>Average Age</td>
<td>19.5</td>
<td>21.5</td>
<td>23.5</td>
<td>25.5</td>
<td>27.5</td>
<td>29.5</td>
<td>31.5</td>
<td>33.5</td>
<td>35.5</td>
</tr>
</tbody>
</table>

### Figure 65. Close Menu Options
A dialog box appears that asks the question, "Save changes to 'F_BOMBER.XLS'?" Choose "Yes" to temporarily save any changes made to this spreadsheet while a different category is investigated. If the results of this run are to be saved as a case for subsequent use, the save case procedure discussed in subsection 11IC7 should be used when exiting from the Age Model. Choose "No" if the changes that have been made do not need to be saved for any future purpose.

To print a selected portion of the active worksheet, highlight the area to be printed, choose the Print pull-down menu, and select the Selected Area option (Figure 66).

Choosing Help from the menu bar (Figure 67) allows selection of on-line information about each of the model's menu bar options. The Help menu provides the Notes option that allows you to attach case-specific note cards to the current run of the model. The Help menu also provides the Version option, which displays descriptive information about the Age Model, including a summary of changes since the prior version.

D. EXITING THE MODEL

To exit the Age Model, choose Exit from the menu bar and choose To ARCS from the pull-down menu (Figure 68). A dialog box presents options for saving the
case under an existing case name or under a new case name. See subsection IIC7 for a detailed description of the save function. To return to the ARCS Main Menu, choose "Save - Exit" or "No Save - Exit." You may also return to the Age Model by selecting "Save - No Exit" or "No Save - No Exit."

Figure 67. Age Model Help Menu Options

Figure 68. Age Model Exit Menu Options

65
VI. THE INVENTORY MODEL

The Inventory Model provides a means of analyzing the inventory requirements and shortfalls for Air Force and Navy tactical aircraft systems.

A. GETTING STARTED

To begin the Inventory Model, choose the Models pull-down menu from the ARCS Main Menu and select Inventory (Figure 69). The selection of a case file is not required at this step, as it is with the other ARCS models, because the data files for the Inventory Model are selected from the model's menu bar. Once the model has been selected, the Inventory Model title screen appears (Figure 70).
B. MENU BAR

The Inventory Model menu bar offers the following nine pull-down menus:

- **File** presents three options for managing the Inventory Model files. First, however, a service needs to be selected before proceeding with any actions. A check mark indicates which service is currently active.
  - **Navy** activates Navy inventory files. A check mark indicates that these files are active and will be affected by the options in the File pull-down menu.
  - **Air Force** activates Air Force inventory files. A check mark indicates that these files will be affected by the options in the File pull-down menu.
  - **Select** allows you to select one of the currently existing inventory files for the selected service.
  - **Delete** allows you to delete one of the currently existing inventory files for the selected service.
  - **Save as...** allows you to save the currently selected inventory analysis file under a new name.
  - **Help** provides access to on-line information about each menu option.
Assignments allows you to edit, add, or delete data in the Assignments table. This table shows the number of each aircraft type assigned to the various wing/squadron types. The pull-down menu provides six options:

- **Edit** allows you to edit any of the existing numerical data in the Assignments table. You may not change aircraft or wing/squadron names.

- **Print** allows you to print the current Assignments table.

- **Add an Aircraft** allows you to add a new aircraft type to the Assignments table.

- **Delete an Aircraft** allows you to delete one of the existing aircraft types from the Assignments table.

- **Add a Wing Type** allows you to add a new wing or squadron type to the Assignments table.

- **Delete a Wing Type** allows you to delete one of the existing wing or squadron types from the Assignments table.

- **Help** provides access to on-line information about each menu option.

Factors provides you with the ability to edit, add, or delete data in the Factors table. This table displays the factors that represent the number of additional aircraft that are necessary for training, R&D activities, and the supply pipeline to ensure that the required number of aircraft are available at the wings and squadrons. The pull-down menu provides four options:

- **Edit** allows you to revise the numerical data shown in the Factors table. You may not edit the aircraft or factor names.

- **Print** allows you to print the current Factors table.

- **Add a Factor** allows you to add a new factor to the table.

- **Delete a Factor** allows you to delete one of the existing factors from the Factors table.

- **Help** provides access to on-line information about each menu option.

Requirements provides you with the capability to edit, add, or delete data in the Requirements table. This table displays the number of each type of wing or squadron that are required in each fiscal year. Six options are provided in a pull-down menu:
- **Edit** allows editing of the numeric data that is currently in the Requirements table. You may not edit wing/squadron names or the fiscal years.

- **Print** allows you to print the current Requirements table.

- **Add Next Year** allows you to add the next year to the table following the last year currently in the table.

- **Insert First Year** allows you to insert an additional year before the first year currently in the table.

- **Delete Last Year** allows you to delete the last year in the current table.

- **Delete First Year** allows you to delete the first year in the current table.

- **Help** provides access to on-line information about each menu option.

- **Inventory** provides you with ways of viewing and analyzing the results of the changes made to the other tables. The Inventory table is usually a product of the data contained in the Assignments, Factors, and Requirements tables, and therefore may not be edited directly. (If the selected inventory file contains explicit inventory data from an external source such as Navy reports of Total Active Aircraft Inventory (TAAI), then the Inventory table may be edited directly. In this case, the menu will provide an **Edit Inventory** option in place of the normal **View Inventory** option.) Six options are provided in the pull-down menu:
  
  - **View Inventory** allows you to view different areas of the Inventory table by scrolling the table in its window. (This option is automatically replaced with **Edit Inventory** for explicitly entered inventory data.)
  
  - **Print Inventory** allows you to print the current Inventory table.
  
  - **Compare to...** allows you to compare the current Inventory table with an Inventory table in a different inventory file. The comparison is calculated by subtracting values in the current table from those in the other table. The results are displayed in the Shortfalls table.
  
  - **View Shortfalls** re-displays the Shortfalls table. The Shortfalls table is normally hidden from view.
  
  - **Print Shortfalls** allows you to print the current Shortfalls table.
- **No Shortfalls** clears the Shortfalls table and the associated files from the work area. If there is no further need for the Shortfalls table, you can improve the speed of most Inventory Model functions by selecting the **No Shortfalls** option. If the Shortfalls table is retained in the work area, then it will be updated along with the other tables whenever a change is made. Choosing **No Shortfalls** eliminates unnecessary processing of the Shortfalls table.

- **Help** provides access to on-line information about each menu option.

- **Charts** provides the capability to produce up to 11 different types of bar and area charts from the data (rows and columns) in the Assignments, Requirements, Factors, Inventory, and Shortfalls tables. In addition to viewing the charts, you may print the charts on an appropriate output device or save the charts to a file. The chart types are listed in the pull-down menu:

  - **Inventory Factors** displays a bar chart of the inventory factors (R&D, training, etc.) for each aircraft type in the Inventory Model.

  - **Selected Wing Configuration** displays a bar chart that shows the number of each type of aircraft in the selected wing. A dialog box prompts you to select a wing type to be charted.

  - **Selected Wing Requirements** displays a bar chart that shows the number of the selected wing or squadron required in each fiscal year. A dialog box prompts you to select the wing type to be charted.

  - **Wing Requirements vs. FY** displays a stacked bar chart showing the number of each type of wing (or squadron) required in each fiscal year. You can convert this chart to an area chart by selecting **Area** from the Style menu on the chart's menu bar.

  - **Selected A/C Distribution** displays a bar chart that shows the number of the selected aircraft that are assigned to each of the wing types. A dialog box prompts you to select the aircraft to be charted.

  - **Selected A/C Inventory** displays a bar chart that shows the inventory of the selected aircraft by fiscal year. A dialog box prompts you to select the aircraft to be charted.

  - **Selected A/C Shortfalls** displays a bar chart that shows the shortage (or excess) of the selected aircraft by fiscal year. A dialog box prompts you to select the aircraft to be charted.
- **A/C Inventories vs. FY** displays a stacked bar chart that shows the aircraft inventories by fiscal year. You can convert this chart to an area chart by selecting **Area** from the **Style** menu on the **Charts** menu bar.

- **Selected FY Requirements** displays a bar chart that shows the requirements by aircraft for a selected fiscal year. A dialog box prompts you to select the fiscal year to be charted.

- **Selected FY Inventory** displays a bar chart that shows the inventory by aircraft for a selected fiscal year. A dialog box prompts you to select the fiscal year to be charted.

- **Selected FY Shortfalls** displays a bar chart that shows the shortfalls (or excesses) by aircraft type for a selected fiscal year. A dialog box prompts you to select the fiscal year to be charted.

- **Help** provides access to on-line information about each **menu** option.

- **Print** provides the capability to print one or all of the tables in the Inventory Model. Six options are provided in a pull-down menu. In each case, a dialog box allows you to select from several print options.
  
  - **Assignments** prints the current Assignments table.
  
  - **Factors** prints the current Factors table.
  
  - **Requirements** prints the current Requirements table.
  
  - **Inventory** prints the current Inventory table.
  
  - **Shortfalls** prints the current Shortfalls table.
  
  - **All Tables** prints all of the current tables, including the Shortfalls table if it is active.
  
  - **Printer Setup** activates a dialog box for setting up the printer. See subsection II.1 for additional information on printer setup.

  - **Help** provides access to on-line information about each menu option.

- **Exit** provides you with two options in a pull-down menu.
  
  - **To ARCS** returns you to the ARCS Main Menu.
  
  - **Excel Menu Bar** provides full access to Microsoft Excel by replacing the model's menu bar with the Excel menu bar. To return to the Inventory Model menu bar, select the **File** pull-down menu from the
Excel menu bar and choose **Return to Model Menu.** See subsection IIC6 for important additional information concerning this procedure.

- **Help** provides access to on-line information about each menu option.

- **Help** provides a pull-down menu allowing you to access on-line information about each menu bar option. You may also access the on-line help by pressing the Help Function Key, F1, when any menu option is highlighted or any dialog box is displayed.

- **Calculator** allows you to call the Windows Calculator to assist in any calculations that are required. After using the calculator, you can "click" on one of the other windows or menus and the calculator will be hidden. To recall the calculator, click again on the **Calculator** option of the **Help** menu. If you desire, you can take the results of the calculator’s operation and insert the value in an appropriate cell of an Inventory Model worksheet. When the calculator is available, its menu includes an option to copy to the Windows clipboard. Later, the value may be pasted to the appropriate cell by typing a "+" in the cell and then pressing the Shift and Insert keys simultaneously. Pasting may be done only when an edit mode has been selected from the Inventory Model menus. Inventory Model tables are protected from any form of data entry at all other times.

- **Notes** allows you to attach case-specific note cards to the currently selected inventory file. See subsection IIC4 for additional information about note cards.

- **Version** displays descriptive version information about the Inventory Model, including a summary of changes since the prior version.

When the model is first started, some of the menus and menu options are "grayed" to indicate that they are not currently available to the user. They will be made available at the appropriate times during the execution of the model.

**C. RUNNING THE MODEL**

To show how the model operates, the category of Navy aircraft will be used as an example.

The **File** pull-down menu of the Inventory Model has three "action" options: **Select**, **Delete**, and **Save as**. You also indicate on this menu which of the services you wish to act on. This is done by clicking on either **Navy** or **Air Force.** For this
example, click on **Navy** and then choose **Select** (Figure 71). A dialog box (Figure 72) appears that lists the currently existing inventory files for the selected service. (If another Inventory Model file is open and has been changed, you will be asked if the current file should be saved before the new file is opened.) For this example, highlight the file "warfight.nav," and click on the "OK" button.

![Image of the Select Option](image1)

**Figure 71. Choosing the Select Option**

![Image of Selecting an Inventory File](image2)

**Figure 72. Selecting an Inventory File**

74
Once the file has been loaded, four tables appear in overlapping windows (Figure 73). The Assignments table is in the upper left, the Factors table is in the lower left, the Requirements table is in the upper right, and the Inventory table is in the lower right. You may bring any table's window to the foreground by "clicking" on any part of the window.

Review each table to become familiar with the information presented. The Assignments table shows the number of each type of aircraft assigned to a specific type of wing or squadron. (These numbers are the Primary Aircraft Authorization or PAA for the wings or squadrons.) The Factors table shows factors that are used to estimate the number of backup aircraft that are needed for special uses outside of the assigned wings. These uses include training, R&D, and the supply pipeline. The factors are added together to indicate the additional multiple of aircraft that are needed to assure the required number are available to the wings. The Requirements table indicates the number of wings (or squadrons) that are required in each fiscal year. The product of the data in these three tables is presented in the Inventory table, which shows the total number of each aircraft type (Total Active Aircraft Inventory or TAAI) required in each of the fiscal years.

To demonstrate the use of the model, choose the Requirements pull-down menu and select Edit. You can now revise any of the existing numeric data in the

Figure 73. Inventory Model Tables
Requirements table. Note that the Edit menu bar appears. Change the number of Transitional wings in FY93 to 4. Choose Exit and select End Editing from the pull-down menu to return to the Inventory Model menu bar. When the editing is completed, the Inventory table is recalculated to show the results of the change.

Now select the Assignments pull-down menu. This menu allows you to make changes to the Assignments table. Select Edit from the pull-down menu. This option allows you to edit any of the existing numeric data in the Assignments table. Note that the Edit menu bar reappears. Revise the number of S-3 aircraft in the Transitional wing to 12. Select End Editing from the Exit pull-down menu to return to the Inventory Model menu bar. When the editing is completed, the Inventory table is recalculated. (If you wish to have the tables recalculated while you remain in the edit mode, you can press the Calculate Function Key, F9.) Click on each of the tables to view their current information.

Select Assignments again, but this time, select Add an Aircraft. A dialog box entitled "Adding a New Aircraft" (Figure 74) prompts you for the name for the new aircraft. Type "F-XX" in the text box and click on the "OK" button. The model enters the data-entry mode and directs you to enter the appropriate assignment and factor data for the new aircraft. Note that the Data Entry menu bar appears. Choose Exit and select End Data Entry from the pull-down menu to return to the Inventory Model menu bar. The Inventory table is then recalculated.

Figure 74. "Adding a New Aircraft" Dialog Box
You may revise the Factors table in a manner similar to that described for the Requirements and Assignments tables.

Now select the Inventory pull-down menu from the menu bar (Figure 75). The Inventory table is the product of the data contained in the Assignments, Factors, and Requirements tables, and normally cannot be edited. Select View Inventory. Note that the View menu bar appears. You can now scroll the window to view different areas of the Inventory table. When you have finished reviewing the Inventory table, choose Exit and select End Viewing from the pull-down menu to return to the Inventory Model menu.

Note that in addition to the Exit menu the Edit, Data Entry, and View menu bars each have several other menus, including Align, Zoom, and Calculator. The Align menu aligns the top-left corner of the data with the top-left corner of the window, and repositions ("homes") the cursor at the top-left cell. This is useful if you have scrolled far down or to the right in the table and wish to return "home" quickly. The Zoom menu either zooms or restores the size of the selected window. The Zoom option on the Zoom menu repositions the top-left corner of the window at the top-left corner of the screen, and then extends the window down and to the right such that the maximum amount of data may be seen without scrolling. The Restore option returns the window to its original size and location once it has been.

### Figure 75. Inventory Menu Options
"zoomed." The Calculator (available on the Edit and Data Entry menu bars) operates in a manner identical to the Calculator option on the Help menu. The Calculator option is not available on the View menu.

To compare the currently selected inventory table with any other inventory table, choose Inventory and select the Compare to... option. A dialog box will prompt you to select the baseline inventory table to be used in the shortfalls comparison. For this example, select "TAALNAV" and click on the "OK" button. The comparison is made by subtracting the currently selected Inventory table from the baseline Inventory table. The calculation is limited to those fiscal years that appear in both Inventory tables and the aircraft that appear in the currently selected table. The results of the comparison are displayed in the Shortfalls table (Figure 76). Negative numbers are shown within parentheses (and in red on color displays).

After viewing the Shortfalls table, close the window by selecting End Viewing from the Exit menu. Subsequent changes to the Requirements, Factors, and Assignments tables will cause the Shortfalls table to be updated as well. To view the effect of any revisions on the Shortfalls table, choose Inventory and select View Shortfalls from the pull-down menu. After viewing the result of the changes, return to the model's menu bar by using the Exit menu. Select Inventory and then No Shortfalls. This will remove the Shortfalls table and the associated files from the
Inventory Model’s work area. (If you retain the Shortfalls table in the model’s work area after it is no longer needed, the Inventory Model will be slower in calculating changes.)

To view charts of the data in the current tables, select the **Charts** pull-down menu from the Inventory Model menu bar (Figure 77). The **Charts** menu provides graphical displays of the data in all of the tables. The word "selected" appears in a number of options in the **Charts** pull-down menu. For these options, a dialog box prompts you to select an aircraft, wing, or fiscal year to be charted. While a chart is displayed, a separate **Chart** menu bar provides several options, including printing the chart and saving the chart to a file.

![Image: Figure 77. Charts Menu Options](image)

To display a bar chart of the inventory factors for each aircraft, choose **Inventory Factors** from the **Charts** pull-down menu. To have the chart fill the entire screen (Figure 78), select **Full Screen** from the **Zoom** menu on the **Chart** menu bar. Select **Window** from the **Zoom** menu to return the chart to its original size.

Now select the **Close** pull-down menu and close this chart by choosing **Chart**. Then select **A/C Inventories vs. FY** from the **Charts** pull-down menu. This chart shows the aircraft inventory as a stacked bar for each fiscal year. Convert this chart
to an area chart by selecting Area from the Style menu on the Chart menu bar. Selecting Close and Chart returns you to the Inventory Model menu bar and the display of inventory tables.

![Inventory Factors Chart](image)

Figure 78. Inventory Factors Chart

Now choose Charts and Selected A/C Inventory. A dialog box prompts you to select the desired aircraft. Select F-14 by highlighting it in the list box and clicking on the "OK" button. After the bar chart appears (Figure 79), choose File from the Save pull-down menu to save the chart to a file and then choose Print from the same menu to send the chart to the printer. A dialog box prompts you to name the file for the saved chart. Choose Close from the Chart pull-down menu to return to the Inventory Model menu bar.

D. EXITING THE MODEL

Once you have performed the desired analysis and prepared any charts that were needed, any files needed for further investigations should be saved. To leave the Inventory Model, choose Exit and select To ARCS from the pull-down menu (Figure 80). A dialog box will prompt you to save or discard the current inventory file. To save the inventory file, you should enter an appropriate file name. (The model will ignore any file extensions added by you and assign the file extension ".NAV" or "AF," as appropriate, to the file. Therefore, you may not use the file
extension to differentiate cases.) After entering the filename, click on the "OK" button. After the file is saved, the ARCS title screen reappears.

Figure 79. Selected A/C Inventory Chart

Figure 80. Exiting the Inventory Model
VII. THE NEW AIRCRAFT MODEL

Previous IDA studies on the costs of developing, producing, and operating aircraft systems have yielded a set of algorithms for estimating such costs. For example, IDA has developed algorithms for fighter aircraft that use cost estimating relationships for avionics, engines, airframes, peculiar support equipment, armament, and production change allowances (see Appendix B). These algorithms were collected and automated in the New Aircraft Model to provide an easy-to-use method for predicting the development, production, and operating and support (O&S) costs of future fighter aircraft.

A. GETTING STARTED

To begin the New Aircraft Model, choose the Models pull-down menu from the ARCS Main Menu and choose the New Aircraft option (Figure 82).

![Figure 82. Starting the New Aircraft Model]
The dialog box entitled "Select Desired Case" appears. The use of this dialog box is described in more detail in Section IIC3. Select the desired option. Once a case has been selected, the New Aircraft Model title screen appears (Figure 83).

![New Aircraft Model Title Screen](image)

**Figure 83. New Aircraft Model Title Screen**

B. MENU BARS

The New Aircraft Model menu structure differs from the structure used in other ARCS models. A diagram of this structure is shown in Figure 6. The following subsections describe the New Aircraft Model menu bar and the Fighter Aircraft menu bar.

1. New Aircraft Model Menu Bar

The New Aircraft Model menu bar offers the following three pull-down menus:

- **Select** allows you to select the type of aircraft to be developed and/or produced. The **Select** menu also includes the printer setup option.
  
  - **Fighters** runs an interactive model that estimates the cost of developing and producing a new fighter aircraft.
  
  - **Printer Setup** activates a dialog box for setting up the printer. See subsection IIC1 for additional information on printer setup.
- **Exit**

  - To **ARCS** closes all files, initiates the save case function detailed in subsection IIC7, and returns you to the ARCS Main Menu.

  - **Excel Menu Bar** provides full access to Microsoft Excel by replacing the model's menu bar with the Excel menu bar. To return to the New Aircraft Model menu bar, select the **File** pull-down menu from the Excel menu bar and choose **Return to Model Menu**. See subsection IIC6 for important additional information concerning this procedure.

- **Help** provides a pull-down menu for access to on-line information about each menu bar option. You may also access the on-line help by pressing the **Help** Function Key, F1, when any menu option is highlighted or any dialog box is displayed. The **Help** menu provides the **Notes** option that allows you to attach case-specific note cards to the current run of the model. See subsection IIC4 for additional information about note cards. The **Help** menu also provides the **Version** option, which displays descriptive information about the New Aircraft Model, including a summary of changes since the prior version.

2. **Fighter Aircraft Menu Bar**

   Choose **Select** from the New Aircraft Model menu bar and choose **Fighters**. Once the category is selected, the following options are available from the Fighter Aircraft menu bar:

   - **Window** is used to manage the display of the New Aircraft Model. The pull-down menu under **Window** is dependent on the mode that you have selected.

     **When the Development Mode is selected:**

     - **Design Characteristics** displays the Design Characteristics window.

     - **Development Parameters** displays the Development Parameters window.

     - **Development Costs** displays the aircraft development costs window.

     - **Development Graph** displays a graph of the development costs plotted as a function of calendar time (if **Set Graph On** has been selected on the **Options** menu.)
- **Arrange All** arranges all of the available windows for simultaneous viewing.

  *When the Production Mode is selected:*

- **Design Characteristics** displays the Design Characteristics window.
- **Production Parameters** displays the Production Parameters window.
- **Production Costs** displays the aircraft production costs window.
- **Production Graph** displays a graph of the production costs plotted as a function of calendar time (if Set Graph On has been selected on the Options menu.)
- **O&S** displays the aircraft O&S costs window.
- **Arrange All** arranges all of the available windows for simultaneous viewing.

- **Mode** controls whether the model is in the Development or Production (and O&S) Mode. When the model is first loaded, it is in the Development Mode.
  - **Development** is used to estimate the costs of developing fighter aircraft.
  - **Production** is used to estimate the costs of producing and maintaining (i.e., O&S costs) fighter aircraft.

- **Options** provides several options for controlling the operation and the look of the New Aircraft Model. It also offers technical help in specifying new aircraft parameters.
  - **Deflate...** is used to edit the deflator factors used by the New Aircraft Model. There are separate deflator factors for the Development and Production Modes.
  - **Colors...** is used to revise the colors used in the various parts of the display.
  - **Examples...** displays design characteristics and factors for selected existing fighter aircraft. This display is intended to aid in the selection of factors and design characteristics for the new aircraft.
  - **Starting Year** displays a dialog box for setting the start year for the development. (The first production year is set when you enter the annual production quantities.)
- **Set Graph Off and Set Graph On** toggle the graphical display of costs.
- **Set Calculate Off and Set Calculate On** toggle automatic recalculation. If Calculate Off is activated (Set Calculate On is displayed in the menu), then the **Calculate Now** option must be used to update costs following any changes to factors or design parameters.
- **Calculate Now** causes the model to recalculate. Use this option to update costs when automatic recalculation has been set off.

- **Graph** provides control of graphical displays of development and production costs.
  - **Options** displays graph format and style options in a secondary menu.
    - **Grid** allows you to add a grid to the current graph.
    - **Graph Type** allows selection of either a line or a bar graph.
    - **Graph Items** allows you to select which schedule you want displayed on the current graph.
    - **Graph Styles** allows you to select the patterns and line styles to be used in the graphs.
  - **View Graph Data** displays a table of the data used to create the cost graph.

- **Exit** provides the option to exit the Fighters model.
  - **Fighters** closes the fighter model and returns you to the New Aircraft Model menu bar.

- **Print** provides a number of options for printing portions of the New Aircraft Model display.
  - **Graph** prints the cost graph.
  - **Graph Data** prints a table of the data appearing in the graph.
  - **Costs** prints the cost table.
  - **Design Characteristics** prints the Design Characteristics (speed vs. weight) graph.
  - **Parameters** prints the window that contains the development or production parameters.
  - **Examples** prints the table of design characteristics for selected existing fighter aircraft.
- Examples prints the table of design characteristics for selected existing fighter aircraft.

- Printer Setup activates the printer setup dialog box. See subsection IIC1 for further information on printer setup.

- Help provides a pull-down menu allowing you to access on-line information about menu bar options. The Help menu also provides the Notes option that allows you to attach case-specific note cards to an individual new aircraft case. See subsection IIC4 for additional information about note cards.

When the model is first started, some of the menus and menu options are "grayed" to indicate that they are not currently available to the user. They will be made available at the appropriate times during the execution of the model.

C. RUNNING THE MODEL

To show how the model operates, the category of fighters will be used as an example. Select Fighters from the Select pull-down menu on the New Aircraft Model menu bar (Figure 84). After the selection has been made, the model is in the Development Mode and the development display is presented (Figure 85). The display consists of three windows. In the upper left is the Design Characteristics window, in the upper right is the Development Costs window, and in the lower portion of the display is the Development Parameters window.

The Design Characteristics window allows you to set two of the principal characteristics of fighter aircraft, the maximum speed (at best altitude in knots) and the aircraft weight (empty weight in pounds of the airframe less the engines, wheels and brakes, avionics, instruments, air conditioning and auxiliary power units, and electrical power equipment). A number of fighter aircraft designations have been placed on the graph at their approximate weight and speed values. To make your selection, click on the appropriate location on the graph. A symbol will mark the location that you have selected, and the corresponding values of speed and weight will appear in the boxes on each axis of the graph. If you want to change your selection, "drag" the marker to the new location.

The Fighter pull-down menus are explained in the following paragraphs. Figure 86 shows the Mode pull-down menu. Because we will be discussing the
Development Mode first, a change is not necessary at this time. The model is already in the Development Mode, as indicated by the checkmark.

Figure 84. Fighters Option

Figure 85. Development Display
The **Options** pull-down menu provides the capability to change the default settings of the model. For example, you can adjust the deflators used in the model's cost calculations. There are separate deflators for production and development costs. The cost estimating equations that are used in the New Aircraft model are described in detail in Appendix B. The development cost equations produce an estimate in FY83 dollars; therefore, the development deflator must adjust from FY83 to the base year of your analysis, i.e., FY91. The production cost equations produce an estimate in FY90 dollars. The production deflator must adjust for the difference between FY90 dollars and base year dollars.

The **Options** menu also allows you to set the start year of the development effort. Selecting **Starting Year** from the options menu displays a list box from which you may select the start year.

You may also change the colors used in various elements of the New Aircraft Model display. Select **Colors** from the **Options** menu. A window appears showing the available colors and the elements of the display that can be changed (Figure 87). Select "Cost background" by highlighting it and then click on any color. The Development Costs window background will change to the newly selected color. Note that the color option is available for "Graph item 1," "Graph item 2," and "Graph item 3." These items are the lines or bars on the development cost graph that represent the "Compressed," "Average," and "Stretched" development schedules.
(discussed later in this section). When color selections are completed, close the "Select Colors" window.

![Figure 87. "Select Colors" Window](image_url)

The Examples... option displays a table of design parameters for existing systems in the selected category. Select Examples... from the Options menu (Figure 88). The model displays system characteristics for a number of previously developed fighter aircraft (Figure 89).

You have the ability to "turn off" the model's automatic recalculation. To do this, select Set Calculate Off from the Options menu. Now, when you want to see the results of any changes, you must select Calculate Now to recalculate costs. To return to the automatic recalculation mode, choose Set Calculate On.

The Window pull-down menu is used to select the various development or production cost and parameter displays. Select Development Graph (Figure 90). The upper right portion of the screen is replaced by the Development Graph window. The graph shows costs for "Compressed," "Average," and "Stretched" development schedules (Figure 91).

The Graph menu menu can be used to customize the display of the cost graphs. Select Graph and, from the pull-down menu, select Options. A secondary menu is displayed to the right of the Options selection. From this menu choose...
Graph Type (Figure 92). Graph Type presents a dialog box from which you select either a line graph or a bar graph. Select "Bar" and click on "OK" (Figure 93). The graph in the Development Graph window changes to a display of the development costs in a bar graph format (Figure 94).

![Figure 88. Examples... Option]

![Figure 89. Examples... Display]
<table>
<thead>
<tr>
<th>Design Characteristics</th>
<th>Development Parameters</th>
<th>Development Costs</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><em>Airframe:</em> 3127.1</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Engine:</em> 1828.2</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Avionics:</em> 1979.9</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>PSE:</em> 682.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Other:</em> 1587.9</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>9347.6</td>
<td></td>
</tr>
</tbody>
</table>

**Development Parameters**

- Contractor Interaction: None, Moderate, Complex
- Engine: Available, Develop
- PSE: Army, Navy, Air Force

<table>
<thead>
<tr>
<th>Technology Index</th>
<th>Advanced Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>0%</td>
<td>50% 100%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Engine Thrust</th>
<th>Avionics Complexity</th>
</tr>
</thead>
<tbody>
<tr>
<td>0%</td>
<td>25% 60%</td>
</tr>
</tbody>
</table>

**Figure 90. Development Graph Option**

**Figure 91. Development Graph Window**

93
Figure 92. Graph Type Option

Figure 93. "Graph Type" Dialog Box
Other **Graph** options include selection of the items (i.e., compressed, average, or stretched development schedule) plotted in the graph and the placement of a grid on the graph. You can also change the display by using the **Colors** option previously discussed.

Now select the **Graph** menu and choose **View Graph Data** (Figure 95). The data table for the graphs is presented (Figure 96). Click on "OK" to close the table.

Now use the **Window** menu and choose **Development Parameters** to bring the Development Parameters window to the front. This can also be done by clicking on any portion of the window you can see on the display. With the Development Parameters window active (Figure 97), you can set any or all of seven development parameters:

- **Contractor Interaction** - An index portraying the extent of major program development activities performed by contractors other than the prime contractor, but executed simultaneously with the prime contractor's development effort. The selections are "None," "Moderate," and "Complex."
- **Engine** - Selects whether the engine is available or must be developed.
- **PSE** - Peculiar Support Equipment (PSE) is developed using the procedures of the military service you choose.

---

**Figure 94. Development Bar Graph**

**Figure 95. Development Parameters Window**

**Figure 96. Development Parameters Table**

**Figure 97. Development Parameters Window**
Figure 95. View Graph Data Option

Figure 96. Development Graph Data Table
Figure 97. Development Parameters Window

- Technology Index - An estimated *engine* technology trend variable that is based on the thrust-to-weight ratio, turbine inlet temperature, and specific fuel consumption of past aircraft engines.

- Engine Thrust - The maximum rated thrust per engine in pounds under sea level static conditions.

- Advanced Materials - The percentage of the airframe structure weight that is made up of titanium, advanced composites, and aluminum honeycomb sandwich material. This value is placed at "1" for aircraft made up of less than 5 percent advanced materials.

- Avionics Complexity - A dimensionless index that ranks the relative avionics complexities and cost of various aircraft.

Change Advanced Materials to 75 percent and Engine Thrust to 36,000 pounds. Set the Contractor Interaction to "Complex," and the PSE to "Navy." When the changes are made, the development costs are recalculated. Use the Window menu to select the Development Costs window. Additional changes may be made to the development parameters to demonstrate the interaction with the calculated development costs.

To change from the Development Mode to the Production Mode, select Mode on the Fighter Aircraft menu bar and choose Production (Figure 98). The display changes to show production-related data. The Design Characteristics
The production quantities are entered in the Production Parameters window. Activate this window by clicking on it. Highlight the first year of production (for example, 1993), type 25 in the aircraft quantities list box, and click on the "Add" button for as many years as you desire (Figure 99). The production for these years is now set at 25 aircraft per year. These numbers may be revised by highlighting the desired year and entering the revised production quantity.

The Production Parameters window also provides the opportunity to set seven parameters that affect production costs. Three are carried over from the Development Parameters window, Technology Index, Engine Thrust, and Advanced Materials. The other parameters are:

- Engines per Aircraft - The number of engines in the aircraft.
- Radar Range - The calculated maximum detection range of the radar in nautical miles.
- EW Input - The maximum required input power in kilowatts calculated for the electronic warfare (EW) system.
- **Airframe Density** - The airframe density ratio is the ratio of the weight of the systems and equipment in the aircraft relative to the structure weight of the aircraft. The systems and equipment weight is calculated by subtracting the structure and engine weight from the aircraft empty weight.

![Figure 99. Changing Aircraft Production Quantities](image)

To view the production costs, select **Production Costs** from the Window menu (Figure 100).

The **Print** menu provides the option to print each of the windows of the current mode. In addition, the **Examples** data table and the data table for the current cost graph may also be printed. **Printer Setup** is also available on this menu (Figure 101).

The **Help** menu provides a description of each of the menu bar options (Figure 102). The **Help** menu also provides the **Notes** option that allows you to attach case-specific note cards to the current run of the model.

**D. EXITING THE MODEL**

To exit the model, choose **Exit** and then **Fighters** on the Fighter Aircraft menu bar. (Figure 103). The New Aircraft Model title screen and menu bar will
Figure 100. Production Costs Option

Figure 101. New Aircraft Model Print Menu Options
Figure 102. New Aircraft Model Help Menu Options

Figure 103. Exiting the Fighter Model
reappear. From that menu select the Exit pull-down menu and choose To ARCS (Figure 104). A dialog box will prompt for a file name with which to save the current run. See subsection II.C.7 for a detailed description of the save function. To return to the ARCS Main Menu, choose "Save - Exit" or "No Save - Exit." You may return to the New Aircraft Model by selecting "Save - No Exit" or "No Save - No Exit."

![Figure 104: Exiting the New Aircraft Model](image)

102
APPENDIX A.

SYSTEM REQUIREMENTS AND INSTALLATION INSTRUCTIONS
APPENDIX A.

SYSTEM REQUIREMENTS AND INSTALLATION INSTRUCTIONS

The ARCS has been designed to operate on a wide range of personal computers (PCs). Depending on the computer selected and its capabilities, modification to the distributed files may be required to ensure proper model operation. The ARCS Install programs will, to the extent possible, simplify the installation process.

SYSTEM REQUIREMENTS

The ARCS models require a PC with at least an 80286 processor. A math co-processor designed to operate with the PC's processor is recommended, but not required. At least 4 megabytes (MB) of memory, suitable for the computer configuration that will be used, is required. Disk storage requirements, although substantial, can be minimized by loading only the model or models needed at any one time. A 20-MB hard-disk storage capacity should be provided for the baseline models, and a 40-MB capacity is recommended if multiple model runs are to be made.

A variety of monitors and printers can be configured to work with the ARCS. Enhanced Graphics Adaptor (EGA) and Video Graphics Array (VGA) color monitors and the HP Laserjet Series II printer have been used during development and should be the easiest to implement for new installations. The hardware requirements for ARCS are shown in Table A-1. Table A-2 lists the software requirements for ARCS.
Table A-1. Hardware Requirements for ARCS

<table>
<thead>
<tr>
<th>Component</th>
<th>Required Hardware</th>
<th>Desirable Hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>80286</td>
<td>80386</td>
</tr>
<tr>
<td>Math Co-Processor</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Memory</td>
<td>4 MB</td>
<td>8 MB</td>
</tr>
<tr>
<td>Mouse</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>20 MB</td>
<td>40 MB</td>
</tr>
<tr>
<td>Monitor</td>
<td>Any</td>
<td>VGA color</td>
</tr>
</tbody>
</table>

Table A-2. Software Requirements for ARCS

<table>
<thead>
<tr>
<th>Version</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DOS</td>
<td>3.1 or higher</td>
</tr>
<tr>
<td>Windows</td>
<td>3.0 or higher</td>
</tr>
<tr>
<td>Excel</td>
<td>2.1d or higher</td>
</tr>
</tbody>
</table>

INSTALLATION INSTRUCTIONS

Both Windows and Excel software should be installed on your equipment before you install the ARCS. Installation of the models is straightforward using routine DOS commands. The models and their supporting data files can be conveniently transferred via floppy disks.

Approximately six floppy disks are required for the entire ARCS. The ARCS directory structure is contained on each disk to facilitate the installation process using the DOS "XCOPY" command. For example, use DOS to move to the root directory of the hard drive selected for ARCS, place the first floppy disk in drive A, and type the following command at the DOS prompt:

```
XCOPY A:\*.* /E/S
```

and press ENTER. All files and directories will be transferred to the selected hard drive. (Drive B may be substituted for Drive A, if necessary.)

The above command statement contains two additional parameters. The/E parameter is used to create subdirectories on the hard drive to match those on the
floppy disk. The /S parameter is used to copy all files in the source directory and in all directories below the starting source directory.

Repeat the XCOPY command for each ARCS distribution disk. After all of the disks have been copied, a batch file must be edited to identify the disk drive on which the ARCS has been installed. Move to the subdirectory "\ARCS" and with any text editor, edit the batch file ARCS.BAT.

If the ARCS has been installed on drive E, the batch file should contain the following:

```
SUBST H: E:\
H:
CD\ARCS
WIN ARCS.XLM
C:
SUBST H: /D
```

If the ARCS has been installed on a drive other than E, substitute the drive letter for the "E" on the first line of the batch file.

The batch file performs the following actions to ensure proper ARCS operation:

- **SUBST H: E:\** uses the DOS substitute command to redefine the hard drive that contains ARCS as the H drive. Since the default value for the last drive that DOS will recognize is "E," your CONFIG.SYS file should be edited with the statement "LASTDRIVE=H." Without this statement, an error message will be issued when the substitute command is entered. Care should also be taken to ensure that your DOS files are in the path statement of the AUTOEXEC.BAT so the substitute command will work properly.
- **H:** changes the default drive to the newly created H drive.
- **CD \ARCS** changes the directory to the ARCS subdirectory on the H drive.
- **WIN ARCS.XLM** executes Microsoft Windows (WIN) and runs the Excel macro program ARCS.XLM in the ARCS subdirectory. The ARCS.XLM macro sheet contains an auto-executing macro that loads the ARCS program.
- C: changes the default drive back to the C drive. This command is executed after leaving ARCS and Windows and will ensure that the next command works correctly.

- SUBST H: /D cancels the drive substitution invoked by the original SUBST command above. (Note: the /D is not followed by a colon. The /D is a delete switch and is correct regardless of the drive specified in the original substitute command.)

At the completion of the installation process, the ARCS models can be used by executing the batch file just created. This is accomplished by typing "ARCS" at the DOS prompt. If this command does not work, check to ensure that the ARCS.BAT file is in the ARCS subdirectory and that the command was executed from that location.
APPENDIX B.

ARCS METHODOLOGY
APPENDIX B.

ARCS METHODOLOGY

The methodologies used by the ARCS are model-specific. In general, Microsoft Excel is used for displaying the inputs and outputs and executing individual "C" programs that perform the calculations. This appendix describes the methodologies used to perform the calculations in each model.

PRE-PROCESSORS

The ARCS Cost and Procurement models use data derived primarily from the Future Years Defense Program (FYDP) to determine the costs associated with alternative force compositions. In order to keep those calculations current and relevant, updates of the data are required each time a new FYDP is published. IDA created data pre-processors to update ARCS data files soon after each FYDP is published. These data pre-processors were developed in conjunction with the Cost and Procurement models to ensure compatibility of the data and calculation methods. The ARCS shares data pre-processors with the Force Acquisition Cost System (FACS), a model similar to the ARCS. Refer to the pre-processor documentation, Pre-Processors of the Force Acquisition Cost System (FACS) (IDA Document D-704) for further information about the data pre-processors.

THE COST MODEL

The purpose of the Cost Model is to calculate and display costs when changes are made to the Future Years Defense Program. Calculations are performed in a separate "C" program (C_PROG.EXE) that is called from an Excel control program (RCM.XLM). Separate calculations are made for the research and development, investment, and operating and support (O&S) costs, and for manpower changes that occur when forces are modified.

The method used by the Cost Model is simple in concept. Forces, and their equipment, organized by Defense Mission Category (DMC), and non-force related
activities are user-modified. When forces are changed, cost factors are used to calculate the marginal cost associated with the change. Results are displayed by appropriation category. Costs are maintained by service and aggregated to produce a DoD total. These marginal cost estimates (delta costs) are added to the baseline costs to produce the revised costs by appropriation and service.

One of the more important assumptions incorporated into the model is that the cost factors for operating and support, investment, and development can be developed from the Future Years Defense Program. These factors, derived in various ways from the current and historical Future Years Defense Program, are assumed to accurately reflect the costs associated with DoD forces. In addition, it is assumed that the Procurement Annex (PA) is an accurate representation of the "cost-quantity" relationship that exists for the weapon systems and munitions being procured. Considerable emphasis has been placed on making the cost factors used by the model available for review and modification. In some instances, separate O&S calculations using parametric equations are made to provide another cross-check to the estimates made by the factors derived from the Future Years Defense Program.

Research and Development Costs

Research and development (R&D) costs are assumed to be proportional to the sum of all other costs for a service or department. The R&D cost change for a given service is calculated by multiplying the appropriate R&D factor by the sum of the O&S and investment cost change calculated by the model. The R&D factors can be viewed and changed prior to making a cost calculation. The factors are derived by calculating a ten-year running average of the ratio of the R&D account to the sum of the investment and O&S accounts.

Prior to any cost calculation, the model permits selection of the cost calculations desired. Through the use of the Set Defaults option on the Calculate pull-down menu, it is possible to select R&D for inclusion in the calculations. When the R&D option is not chosen, R&D costs will not be changed in subsequent calculations.
Investment Costs

Changes in investment costs are calculated by adding together the separate estimates for major procurement, other investment, and military construction. Major procurement calculations are made for systems that have been identified from the PA as having a cost-quantity relationship. Other investment costs are the sum of the costs calculated for other procurement and support investment.

Major Procurement Costs

Costs for the procurement of major systems are calculated using factors derived from service data displayed in the Procurement Annex. Other parameters are either calculated by the pre-processor or added manually. These other parameters are:

- **Procurement Factor** - a multiplier applied to the requested force change to cause additional quantities to be procured that will satisfy the requirements for training, maintenance pipeline, attrition reserve, and force structure. The procurement factors used in the model are derived from official sources. When a factor is not available, the pre-processor enters the value 1.

- **Lead Time** - the time required to procure an end-item of equipment measured from the time resources are applied. Times are expressed in years and derived from official sources, or entered by the pre-processor based on the cost of the system when a actual lead time is not know.

- **First-Unit Cost and Slope (exponent)** - the parameters that describe the learning curve represented by the system's cost-quantity relationship in the PA. The first-unit cost and slope are calculated by the procurement pre-processor.

- **Initial Spares Factor** - a factor used to estimate the cost of initial spares for each new system. The factor is calculated by the procurement pre-processor and is the percentage of total program cost programmed for initial spares.

The procurement calculation occurs in several steps. First, the force quantity change is multiplied by the procurement factor for each year that a change was requested, and lead time is applied to generate a revised procurement plan. Costs
are calculated for the baseline procurement plan and then for the revised procurement plan, and the resulting difference is the marginal cost change for the new quantity. These total procurement costs are calculated for a given number of systems, N, by taking N to the BETA power, where BETA = 1 + \ln(SLOPE)/\ln(2), and then multiplying this quantity by the first-unit cost. The cost for initial spares is calculated and the resulting costs are added to the appropriate appropriation category in the DMC that contains the system. The Cost Model aggregates procurement costs by appropriation category for each model run. Cost changes generated for each system are preserved and written to a separate file for viewing if desired. Cost factors used in the calculations, described above, are available for review or modification when using the model.

The procurement module of the Cost Model assumes that procurement of any system will be decreased in any year when its corresponding force structure is reduced. In some instances, it may be desirable to continue procurement even though the corresponding force structure may be reduced. To a limited degree, this position can be accommodated by not selecting procurement to be calculated when defaults are modified using the Set Defaults option on the Calculate pull-down menu. When "Procurement" is selected, procurement costs for the revised procurement plan will be calculated. When "Procurement" is not selected, no costs will be calculated for any procurement.

Other Investment Costs

Other investment costs are made up of other procurement and support investment costs:

- Other procurement costs. Generally, a cost-quantity relationship does not exist in the PA for most items procured by the other procurement appropriation. Cost factors are used to estimate the changes that occur in the other procurement appropriation when a force structure change is made. These factors are calculated in the appropriations pre-processor and represent the ratio of other procurement to total costs less research, development, test, and evaluation (RDT&E), military construction, and other procurement. The factor is applied after all other procurement calculations have been made by the Cost Model.
• Support investment costs. The support investment cost change consists of cost estimates for changes in modifications, replenishment spares, and support equipment and facilities (MRS). It is calculated using the factors developed in the pre-processor. The factors are applied to the cost changes calculated by the Cost Model for direct operations and maintenance (O&M) costs. This procedure assumes that the cost changes for MRS are a function of the operating tempo of the forces. In this instance, operating tempo is represented by the operations and maintenance funding change. Cost calculations for MRS are made each time the model calculates results. Separate tables are prepared to itemize the MRS costs if requested using the Set Defaults option prior to calculation. Selecting "Create MRS Output Report" in the "Set Defaults" dialog box causes the separate cost table to be generated. When it is not selected, no table is prepared even though the calculations are made and added to the normal cost output tables. Calculation time is reduced when the MRS table is not prepared.

Military Construction Costs

Military construction (MILCON) costs are assumed to be proportional to the total costs less RDT&E, military construction, and Other Investment costs. The factors are derived in the appropriations pre-processor from a ten-year running average of the ratio of the MILCON to total cost ratios. The MILCON cost change is calculated for each service by multiplying the appropriate MILCON factor by the change in all the investment accounts, less MILCON. Factors used for MILCON calculations can be reviewed and modified prior to each model execution.

Operating and Support Costs

The Cost Model calculates operating and support (O&S) costs using two separate methods. The first, or factor method, uses cost factors derived from the Future Years Defense Program and calculates the direct and direct plus indirect (total) costs associated with each force change. Separate factors are developed and used for calculating the changes to the operations and maintenance (O&M), military personnel (MILPERS), and other operations appropriations for each force structure system or unit. The second, or parametric method, estimates O&S costs
based on the relationship of selected system characteristics to their historical O&S costs.

O&S cost changes are calculated by multiplying the individual O&S cost factors that represent the cost per force element by the change in the number of force elements. Files containing the O&S cost factors per force element for both direct and direct plus indirect costs are available for review or modification prior to each calculation of the model. These files are prepared by the pre-processor at the same time as the force files (organized by DMC). They can be viewed or modified using the Edit menu option from the Cost Model menu bar. In general, the direct costs are derived from the primary Program Elements of the force element, and the indirect costs are the result of allocations made from support missions to the combat missions using the Advanced Mission-Oriented Resources Display (AMORD) procedure. These indirect costs are for functions that include management headquarters, base operations, central supply operations, and logistics and personnel support.

All O&S cost estimates are dependent in some way on the AMORD. All current Future Years Defense Program resources are processed by the AMORD prior to the development of the cost factors used by the Cost Model. In contrast, the parametric method does not use current Future Years Defense Program cost data for estimating changes in O&S costs. The regression equations used for the parametric estimates were developed using historical Future Years Defense Program data processed by the AMORD routines. Without the use of the AMORD, neither procedure could be performed in its present manner.

O&S Weight Factors

In some cases, different types of forces are assigned to the same Program Element (PE) of the Future Years Defense Program. When the cost factors for these systems are developed, relative weights must be assigned to the force units in order to estimate the changes in the O&S cost components. This step is accomplished in the pre-processor, but requires that weights be assigned to all systems being processed. Since factors are developed at the PE level, the weight assigned to a force element is particularly important when more than one system or unit is assigned to the PE. When the PE contains a single force element, the cost factors will be based on the total cost divided by the number of units in the PE.
O&S Spread Factors

Changes in O&S costs calculated by the Cost Model as a result of a specified force change will likely not all occur in the year that forces are changed. Indirect cost changes, in particular, may lag force changes by several years. Spread factors allow the O&S cost changes (resulting from changing the number of force units of a particular type) to be spread over several years. In addition, the spread factor can also be used to designate a portion of the O&S costs as "fixed" by decreasing the total percentage of the spread to less than 100% (a generalization of the concept of fixed and variable costs). The spread factors can be reviewed and modified prior to any calculation using the Edit pull-down menu from the Cost Model menu bar. Existing research on appropriate spread factors is minimal. New efforts are currently under way to investigate the problem further.

Advanced Mission-Oriented Resources Display (AMORD)

The primary tool used to develop O&S cost relationships for forces is the AMORD program developed by IDA for the Office of the Assistant Secretary of Defense (Program Analysis and Evaluation) (OASD(PA&E)). AMORD accomplishes two fundamental steps that are necessary for the O&S calculations. First, the Program Elements (PEs) of the Future Years Defense Program are separated into unique combat (direct) or support mission (indirect) categories. Second, all resources of the indirect mission categories are allocated among the direct mission categories. This is done at the PE level of detail. The AMORD output is then used to relate the O&S resources assigned to a direct PE with the forces included in that PE and to create the factors that represent the marginal O&S costs of each force element.

AMORD consists of a set of rules developed by IDA for OASD(PA&E) to allocate all of the resources of the Future Years Defense Program to mission-related, direct Program Elements instead of the Major Force Programs (MFPs) used in the Future Years Defense Program. This allocation process is performed in order to display the resource in a format more useful in answering questions related to the costs of missions than is possible using the MFP structure displayed in the Future Years Defense Program.
AMORD is the first procedure used to derive the factors used by the Cost Model as the basis for all O&S costs for forces. This is accomplished by assigning each direct Program Element to a row of the AMORD output matrix, where the rows are direct Program Elements and the columns are the resource category breakouts of direct and indirect resources. An example of the output matrix is shown in Figure B-1. For example, all the resources of PE 0101127F, B-2 Squadrons, would be placed in the row labelled "0101127F" in the columns labelled "Direct Resources." Other PEs that provide support to the B-2 would have a portion of their resources allocated to the same row in the columns labelled "Indirect Resources." When the AMORD allocation procedure is completed, the sum of the resources in the B-2 row would indicate the mission-related cost of the B-2 program including such diverse costs as family housing, flight training, medical support, and central headquarters support.

![Figure B-1. AMORD Matrix](image)

The AMORD model accomplishes the allocation of support resources among the direct mission Program Elements by following a set of rules that specify how these support resources will be split and which direct missions (Program
Elements) will receive the allocated resources. This process is accomplished in six steps.

- Step 1 assigns the resources in a direct PE to the "Direct Resources" columns of the output matrix.
- Step 2 allocates operational support, general R&D, and systems support resources to matrix cells in the appropriate rows ("Direct Program Elements") and columns ("Indirect Resources").
- Step 3 allocates base operations and management headquarters resources among the "Direct" rows of the matrix.
- Step 4 allocates central supply operations, equipment maintenance, and logistics support resources among the "Direct" rows of the matrix.
- Step 5 allocates the central personnel acquisition, training, medical, individuals, federal agency, and other personnel support resources among the "Direct" rows of the matrix.
- Step 6 allocates the overhead costs of the departmental headquarters and any undistributed adjustments to the "Direct" rows of the matrix.

Each allocation in each step requires some basis to be used to determine the ratio of the support resource allocation to any particular direct Program Element. The basis element used can represent such variables as funding (total obligational authority, operations funding, R&D funding, etc.), numbers of people (total personnel, enlisted personnel only, etc.), or force types (all surface ships, aircraft, aviation units). The basis variable used for each type of allocated resource is determined by OASD(PA&E).

At the completion of all AMORD programs, the total resources (both direct and indirect) associated with a particular direct mission and its Program Elements can be determined from the matrix rows of the AMORD output.

### O&S Factors Development

Upon completion of the AMORD computer program, additional processing of the output matrix is required to develop the O&S factors used in the Cost Model. O&S factors are calculated by dividing the funding that AMORD assigns to a direct Program Element by the number of force units assigned to the PE. However, if
more than one force element is in a PE (as is the case for the B-2 PE in Figure B-1), then a weighting procedure must be used to divide the funding.

Several different weighting schemes are used for relating forces to the resources for each PE. In some cases, the number of personnel assigned to units has proven to be a reasonable surrogate, particularly for the MILPERS portion of the O&S funding. In other cases, the DoD Visibility and Management of Operating and Support Costs (VAMOSC) data are used to derive relative weighting values. In the example shown in Figure B-2, since there is only a single force element in the B-52 and B-1 PEs, a weight is not really necessary; the O&S values for these PEs are simply divided by the number of aircraft to arrive at an O&S per aircraft factor that is then used in the Cost Model. For the B-2 PE, however, VAMOSC weights are assigned to the B-2 and T-38 trainer to represent the relative cost of operation of each aircraft.

<table>
<thead>
<tr>
<th>PROGRAM ELEMENT</th>
<th>TYPE OF FORCE</th>
<th>NUMBER OF UNITS</th>
<th>O&amp;M FUNDING (Dollars)</th>
<th>UNIT O&amp;M WEIGHT (Dollars)</th>
<th>TOTAL O&amp;M WEIGHT (Dollars)</th>
<th>FUNDING PER UNIT WEIGHT</th>
<th>O&amp;M FACTOR (Dollars Per Unit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0101113F</td>
<td>B-52</td>
<td>100</td>
<td>1000</td>
<td>14</td>
<td>Not Required</td>
<td>Not Required</td>
<td>10</td>
</tr>
<tr>
<td>0101126F</td>
<td>B-1</td>
<td>80</td>
<td>560</td>
<td>10</td>
<td>Not Required</td>
<td>Not Required</td>
<td>7</td>
</tr>
<tr>
<td>0101127F</td>
<td>B-2</td>
<td></td>
<td>66</td>
<td>10</td>
<td></td>
<td></td>
<td>1.1</td>
</tr>
<tr>
<td>B-2</td>
<td>5</td>
<td></td>
<td>9</td>
<td>45</td>
<td></td>
<td></td>
<td>9.9</td>
</tr>
<tr>
<td>T-38</td>
<td>30</td>
<td></td>
<td>0.5</td>
<td>15</td>
<td></td>
<td></td>
<td>0.55</td>
</tr>
</tbody>
</table>

*aDoD VAMOSC (Visibility and Management of Operating and Support Costs) data are generally used as weights for aircraft. However, since the B-2 is a new system, no VAMOSC data are available. For this example the B-2 unit O&M cost is assumed to be 90 percent of that of the B-1.

*bFor example, if the number of B-52s were decreased by 5 the direct annual O&M cost would be reduced by $50 million (i.e., 5 x $10 million).

Figure B-2. Example of O&M Cost Factor Development

THE PROCUREMENT MODEL

The purpose of the Procurement Model is to display the information contained in the Procurement Annex (PA) and to permit changes to be made to the quantities of aircraft being procured. In addition, the aggregate costs of
modifications, replenishment spares, and support equipment and facilities (MRS) are displayed individually so they may be changed if desired. Costs, by appropriation category, are displayed at all times. The Procurement Model is a stand-alone application in Microsoft Excel. Results of any calculations performed can be printed if desired.

**Preparation of the First-Unit Cost and Slope**

The procurement pre-processor prepares the data for the Procurement Only Model. The data files originate with the "raw data" of the PA and are brought into the model from the Process menu. Calculations are made to produce the first-unit cost and slope for the systems that have a cost-quantity relationship. *It is important to understand that the first-unit cost and slope produced by the pre-processor is not the first-unit cost and slope for the entire program but merely that portion of the program that is contained in the PA.* Checks are performed on the calculations to prevent unrealistic values from being used. For example, a line is "fit" to the data using regression techniques. When the calculated slope falls outside the range of 0.7 to 1.0, the slope value of 1.0 is used, and the first-unit cost is recorded as the average unit cost of the system. In addition, if the regression equation produces an $R^2$ less that 0.5, the slope is again forced to 1.0 and the average unit cost is used as the first-unit cost.

When the **Prepare New Input Data** choice is initiated from the Process pull-down menu and the necessary files are present, the files and the formula necessary to effect the calculations made by the model are loaded for each of the appropriation categories displayed by the model. These appropriations are:

- Navy Aircraft
- USAF Aircraft

**Cost Ratios for Advanced Procurement and Initial Spares**

Cost ratios for advanced procurement and initial spares are calculated by the procurement pre-processor and passed to the model as a formula when the data are loaded into the model. Cost ratios reflect the relationship between the weapon system costs and the advanced procurement for the current and prior year. When quantities are changed in the model, the ratios are used to estimate the advanced
procurement appropriate for the change. In a similar manner, ratios are calculated for the initial spares and applied when quantities are changed.

THE AGE MODEL

The purpose of the Age Model is to calculate the average age of combat aircraft. Aircraft types are grouped into categories that include Army, Navy, and Air Force aircraft in this Excel model. When a category is selected, a dialog box permits the selection of specific aircraft types to be included for analysis. When the choice of specific aircraft is made, the spreadsheet calculates the overall average age of the selected aircraft and the average age of the individual aircraft types for the period 1987-2005. Features available in Excel permit shading to reflect cells of the spreadsheet that should not be modified by the analyst because they generally represent values that are calculated. The actual formula used for the calculation is displayed on the formula bar at the top of the screen.

Changes are made to the age profiles for individual aircraft types by first selecting the types to be modified. Changes are allowed to the planned procurement or to the retirement schedule. In addition, attrition can be affected by entering an absolute value or by accepting the model attrition rates for the average age calculations. Deliveries of the systems that have ongoing procurement, Total Active Aircraft Inventory (TAAI) and a value that represents the supportable Primary Aircraft Authorization (PAA) are also displayed.

For use within the model, deliveries are calculated and displayed based on a procurement lead-time. The TAAI line is a summation of the starting inventory (preloaded into the model at a known time and age) and deliveries for the scheduled procurement less any planned retirements. Supportable PAA is a calculated value based on a percentage of the total inventory deemed to be necessary to support the combat forces. This percentage can be viewed on the formula bar whenever a cell on the row for supportable PAA is selected. The percentage used for supportable PAA can be modified. The PAA value, as it declines through attrition and retirements, provides an indicator of the number of combat aircraft that can be properly supported by the active inventory of aircraft.

Attrition equations are dependent upon the flight hours and the planned flying-hour program for each type of aircraft. The equation is duplicated on the spreadsheet for each year that a calculation is made. For Navy systems, the attrition values are taken directly from Navy data and are not calculated based on flying hours as they are for Air Force systems.

The average age shown is for each aircraft type and is not based on a tail-number-by-tail-number accounting approach. The assumption is made that the aircraft were manufactured evenly over the production span of years for the particular system.

The equations used in the model were developed in concert with Dr. Royce Kneecce, in the Office of the Under Secretary of Defense (Acquisition.) Average age is calculated as explained below.

Given that "A" aircraft were produced over "K" years starting in year "M₀+1", and it is now year "N", with "N > M₀ + K", and with the simplifying assumption that "A/K" aircraft were ordered each year, then the average of those aircraft is:

\[ N - M₀ - K/2 \] (1)

If "R" aircraft are retired in year "N", and the oldest are retired first, then the remaining aircraft were procured over the interval; and their production span was:

\[ M₀ + R/(A/K) to M₀ + K \] (2)

or

over \( K \cdot (1 - R/A) \) years . (3)

From Equation (1) then, the average age of these aircraft is:

\[ N - M₀ - 1/2 \cdot (K \cdot (1 - R/A)) \text{ years} \] (4)

or

\[ N - M₀ - K/2 \cdot (1 + R/A) \] . (5)

To use these equations in the model, it is necessary to calculate, and carry along on the spreadsheet, a theoretical production start date "M" and a theoretical production interval "K" for the active TAAI. These values are calculated in each column of the spreadsheet in the following manner:

\[ Mᵢ = Mᵢ₋₁ + R \cdot Kᵢ₋₁/A \] (6)
and
\[ K_i = K_{i-1} - R \cdot \frac{K_{i-1}}{A} \]  
(7)

or
\[ K_i = K_{i-1} \cdot (1 - \frac{R}{A}) \]  
(8)

For in-production aircraft, the values are:
\[ M_i = M_{i-1} = M_0 \]  
(9)

and
\[ K_i = K_{i-1} + 1 = N_i - M_0 \]  
(10)

The average age for the year "i" is computed using the prior "M" (\(M_{i-1}\)), prior "K" (\(K_{i-1}\)), and prior "A" (\(A_{i-1}\)), but the current year "N_i".

Because attrition assumes an average age aircraft, it need not be included in figuring the average age. Deliveries, however, must be considered. If "D_i" represents the current year deliveries, and assuming that they are delivered evenly throughout the production years, then the average age (\(AA_i\)) is calculated using the following equation where "X" represents the number of aircraft attrited in the year:
\[ AA_i = \left[ (AA_{i-1} + 1) \cdot (A_{i-1} - X) + D/2 \right] / A_i, \]  
(11)

which represents the aircraft years of the remaining aircraft plus half of a year for each new delivery divided by the new TAAI, where:
\[ A_i = A_{i-1} - X + D \]  
(12)

THE INVENTORY MODEL

The Inventory Model is a requirements-driven spreadsheet model of Total Active Aircraft Inventory (TAAI). Each inventory scenario is stored as a single Microsoft Excel spreadsheet consisting of five tables: Assignments, Factors, Requirements, Inventory, and Shortfalls, plus additional information required by the model. The Assignments, Factors, and Requirements tables can be thought of as the independent variables in an inventory equation that features the Inventory and Shortfalls tables as the dependent variables. The commands on the Inventory Model menu bars provide a complete user interface to all aspects of the inventory problem. The Inventory Model is written completely in Microsoft Excel macro code.
The operation of the Inventory Model is predicated on the existence of a small number of inventory files that are delivered with the model. Any subsequent inventory files developed by the user must be derived from an existing file. Given the relatively small amount of data associated with the model, a data pre-processor is not required for the Inventory Model. New or updated sources of data are entered manually into the appropriate inventory files using the model's menus.

Upon entering the model, you would normally select an existing inventory file from a list presented in a dialog box. Following your selection, the Assignments, Factors, Requirements, and Inventory tables appear, each in a separate window, and appropriate menu items are activated. At this point, the user may add, delete, edit, print, chart, or just browse the inventory data displayed. A comparison to another inventory scenario may also be made at this time. To display the comparison, a fifth window is created for the Shortfalls table.

Each number in the Inventory table is the product of corresponding data in the Assignments, Factors, and Requirements tables. Basically, the inventory equation is:

\[
\text{Aircraft Type per Year} = (\text{Aircraft Type per Wing Type}) \\
\times (1 + \text{Total of Factors}) \times (\text{Wing Type per Year}),
\]

or simply:

\[
\text{Inventory} = \text{Assignments} \times \text{Factors} \times \text{Requirements}.
\]

The size of the Inventory table is dictated by the number of aircraft types in the Assignments table and the number of years in the Requirements table. Each time either of those variables is changed by adding or deleting aircraft or years, the Inventory table changes at the same time. Numbers in the Inventory table are recalculated automatically each time the corresponding data in another table are edited.

The Assignments table shows the number of each aircraft type assigned to a given wing or squadron type. Each row displays the configuration of a given wing, while each column of the table shows the distribution of a given aircraft type across wing types. All data in the Assignments table are user supplied, and may be edited, graphed, and printed.
The Factors table shows several factors used to determine how many additional aircraft are needed to support those deployed to wings (Assignments - Requirements). Separate factors are usually included for Fleet Readiness Squadrons (training), operating and support (O&S), and pipeline. Each factor in the model is a number less than one that when multiplied by the deployed number of aircraft results in a number of additional aircraft needed for the activity represented by the factor. To compute the TAAI, the deployed number of aircraft is multiplied by the sum of the factors plus one. All data in the Factors table are user-supplied, and may be edited, graphed, and printed.

Once wing configurations and procurement factors have been established, the Requirements table becomes the focus of Inventory Model activity. Through the Requirements table you may specify force levels over time by entering the number of each wing type required in each fiscal year. All data in the Requirements table are user-supplied, and may be edited, graphed, and printed.

The Inventory table takes one of two forms. Usually the Inventory table displays the results of Excel formulas similar to the inventory equation above. These formulas reference the other tables on the spreadsheet. In such cases you are prohibited from making manual changes to the table. All changes are automatically calculated by the model. The second form of the Inventory table consists of explicitly entered numbers, not formulas. These numbers may be changed by editing the table through the Inventory menu. The model automatically determines the form of the Inventory table that is resident on an inventory spreadsheet and provides either a view or edit option on the Inventory menu, as appropriate. The purpose of the second form of the Inventory table is to provide a method by which you can enter actual (or projected) inventory data independent of the other tables on the sheet. In fact, since in this situation there are no formulas in the Inventory table, the other tables are meaningless and are set to ones or zeros, as appropriate. Any inventory file containing the explicit form of the Inventory table may be used to generate other similar inventory files. These files are normally used as the baseline data when you make a comparison with another inventory.

The Shortfalls table is created when the Compare to... option is selected from the Inventory menu. A dialog box prompts you to select a baseline inventory from the available files. At this point you would most likely select an inventory file with actual inventory data in its Inventory table as discussed above; however, the
comparison may be made to any inventory file. Following the selection of the baseline inventory file, the Inventory Model creates the Shortfalls table by subtracting the data in the currently selected table from the data in the baseline table. Negative numbers indicate shortfalls relative to the selected baseline (actual or projected inventory), and positive numbers indicate an excess relative to the baseline. A few simple rules are followed when creating the Shortfalls table:

- The range of fiscal years in the Shortfalls table is the intersection of the years in the two Inventory tables being compared. Any fiscal year not common to both tables is meaningless in the shortfalls analysis.

- The Shortfalls table contains all of the aircraft types in the currently selected Inventory table, regardless of whether or not they are also in the baseline Inventory table. If an aircraft is in the selected Inventory table and not in the baseline table, then the entire inventory is excess relative to the baseline position. If an aircraft type in the baseline Inventory table is not in the selected table, it is not included in the shortfalls analysis.

The Shortfalls table is normally hidden from view. You can display it by using the View Shortfalls option on the Inventory menu. It will remain displayed until you exit from the view mode using the Exit menu on the View menu bar. While the Shortfalls table is active (and hidden), it is updated in the same manner and at the same time that the Inventory table is updated. Any changes that result in a change in the Inventory table will also be reflected in the Shortfalls table as long as the change occurs in a year that is in common with the baseline Inventory table. The automatic processing of the Shortfalls table adds to the Inventory Model's internal overhead, which may make the model appear to be slower than expected. If there is no longer a need to have the Shortfalls table active, it can be removed by using the No Shortfalls option on the Inventory menu.

In general, the Inventory Model has been structured to prevent access to any of the inventory data except through the menu selections. For instance, data in the Assignments table may not be edited without using the Edit option on the Assignments menu. In addition, some protection against invalid data entry has also been provided. For example, the edit mode of the Assignments table will not allow the entry of negative numbers or text. Invalid entries are tagged as errors, and you
will be asked to correct them before being allowed to exit the edit mode. The Inventory Model provides access to the standard Excel menus on the Exit menu. Only an experienced Excel user should exercise this option. Using the Excel menus, it is possible to leave the inventory files in an unknown state relative to the model. It is always best to use the Inventory Model menus when dealing with inventory files. If Excel is entered from the Inventory Model, the last item on the Excel File menu is Return to Model. Assuming that no other processing has taken place, this command will restore the appropriate Inventory Model menu bar, and inventory processing may proceed as if uninterrupted.

Any exit from the model invoked from model menus will prompt you to save the current inventory file. It may be saved under its own name or under a new or previously used name. If you ask the model to write over an existing inventory file, a subsequent dialog box will ask for confirmation before the file is written to disk. The Shortfalls table is not saved with the inventory file, therefore if the data in the Shortfalls table is important you should print it or chart it before exiting. The Shortfalls table is transient because it is based on the data in the baseline Inventory table, the status of which can not be guaranteed once the selected inventory file is closed.

THE NEW AIRCRAFT MODEL

The New Aircraft Model is unique among the models of the ARCS. Access to this model is provided through Excel but once an aircraft type is selected, control is passed to a "C" program where it remains until you exit the model. The "C" program provides a graphical user interface (GUI) that allows the model to base calculations on the positions of slide bars, cross hairs, and other markers set by the user. The purpose of the model is to calculate the costs associated with the development, production, and operation of fighter aircraft.

The GUI of the New Aircraft Model displays development and production parameters based on the mode of operation selected. For development of fighters, choices can be made for the weight, speed, engine thrust, percent advanced materials, etc., that determine the cost of developing the new aircraft system. Cost estimates are based on other studies at IDA that produced the cost estimating relationship (CER) used in the calculations. Similar parameters are necessary for
the production phase. Cost tables are updated whenever a change is made to an input parameter. The data can also be displayed in the form of a graph.

**Development Costs**

The fighter development cost estimates produced by the New Aircraft Model are based on the following relationships:

\[
\text{Airframe} = 0.0326 \times \text{Weight}^{-0.72} \times \text{Speed}^{0.43} \times \text{Advanced Materials}^{-1.1} \times \text{Contractor Interaction}^{-0.73}
\]

\[
\text{Engine} = 0.10 \times \text{Technology Index}^{-0.79} \times \text{Thrust}^{0.48} \times e^{(\text{Supersonic Dummy x 0.73})}
\]

\[
\text{Avionics} = 60 \times \text{Avionics Complexity}
\]

\[
\text{PSE} = 0.036 \times e^{[2.17 \times \text{Service Dummy}]} \times (2000)^{1.0}
\]

\[
\text{Other Costs} = 412 + 0.134 \times (\text{Airframe} + \text{Avionics} + \text{Engine} + \text{PSE})
\]

where

- **Weight** = aircraft weight in pounds.
- **Speed** = aircraft speed in knots (nautical miles per hour).
- **Supersonic Dummy** = 1 for supersonic aircraft, otherwise 0.
- **Service Dummy** = an index designating the military service for which the aircraft was developed. It is set to 1 for the Air Force, otherwise 0.
- **Contractor Interaction** = an index portraying the extent of major program development activities performed by contractors other than the prime contractor, but executed simultaneously with the prime contractor's development effort. The selections "None," "Moderate," and "Complex" result in an index between 1.25 and 2.5.
- **Technology Index** = an estimated engine technology trend variable that is based on the thrust-to-weight ratio, turbine inlet temperature, and specific fuel consumption of past aircraft engines.
- **Thrust** = the maximum rated thrust per engine in pounds under sea level static conditions.
- **Advanced Materials** = the percentage of the airframe structure weight that is made up of titanium, advanced composites, and aluminum honeycomb sandwich material. This value is set to 1 for aircraft made up of less than 5 percent advanced materials.
Avionics Complexity = a dimensionless index that ranks the relative avionics complexities and cost of various aircraft.

The results of the equations for development costs are expressed in millions of FY83 dollars. A development deflator must be used to adjust from FY83 to the base year of your analysis, i.e., FY91.

Production Costs

The equations below are used to estimate normalized unit costs. The subscripts define how each is normalized: UC100 and UC1000 indicate 100th-unit and 1000th-unit cost, and AUC indicates program average unit cost. The TIME and TIME\textsubscript{66} variables are defined as the year of first production minus 1900 and 1966.

\begin{align*}
\text{Airframe}_{UC100} &= .00446 (\text{Weight})^{.82} (\text{Advanced Materials})^{.73} \\
\text{Engine}_{UC100} &= .000183 (\text{Technology Index})^{.33} (\text{Thrust})^{.78} \\
&\quad \times e(\text{Supersonic Dummy} \times .21) \\
\text{Radar}_{UC100} &= -1.39 + .063([\text{Radar Detection Range}] / 1.68) \\
&\quad + .016(\text{TIME}) \\
\text{Electronic Warfare}_{UC100} &= -1.81 + .127 (\text{EW Input Power}) \\
&\quad + .026(\text{TIME}) \\
\text{Other Avionics}_{UC100} &= .618 + .45 (\text{Radar}_{UC100} + \text{Electronic Warfare}_{UC100}) \\
&\quad + .053(\text{TIME})^{.66} \\
\text{Airframe PGSEA}_{AUC} &= .072 \times (\text{Airframe}_{UC100})^{1.47} \\
\text{Engine PGSEA}_{AUC} &= .921 (\text{Engine}_{UC100})^{1.21} (\text{Aircraft Quantity})^{-3.37} \\
\text{Avionics PGSEA}_{AUC} &= .12 + .23 (\text{AV}_{UC100}) ,
\end{align*}

where

\begin{align*}
\text{Radar Detection Range} &= \text{the calculated maximum detection range of the radar in nautical miles.} \\
\text{EW Input Power} &= \text{the maximum required input power in kilowatts required by the electronic warfare (EW) system.} \\
\text{Airframe Density} &= \text{the ratio of the weight of the systems and equipment in the aircraft relative to the structure weight of the aircraft.}
\end{align*}
The systems and equipment weight is calculated by subtracting the structure and engine weight from the aircraft empty weight.

Program costs are derived from unit cost estimates using learning curve equations. For engines and avionics, the 91% and 90% curves are used. For airframes, the equation is:

\[ b = -.076 - .165 \left(\frac{\text{Airframe}_{UC100} \times 1000}{\text{Weight}}\right) \]

where \( b \) is the learning curve coefficient.

Once the program costs for these elements are calculated, they are aggregated to reflect the cost structure displayed in the ARCS. Below is a list of the aggregations along with cost relationships derived from program costs.

- **Avionics** = Radar + Electronic Warfare + Other Avionics
- **Other Flyaway** = .035 (Airframe + Engine + Avionics)
- **Total Flyaway** = Airframe + Engine + Avionics + Other Flyaway
- **Other Support \(_{AUC}\)** = .36 (Total Flyaway \(_{AUC}\))\(^9\) (Aircraft Quantity)\(^{-21}\)
- **Total Support** = Airframe PGSE + Engine PGSE + Avionics PGSE + Other Support
- **Weapon System** = Flyaway + Support
- **Initial Spares** = .07 (Weapon System)
- **Total Production** = Weapon System + Initial Spares.

Because the production cost equations provide an estimate in million\(^\text{\$}\) of FY90 dollars, a production deflator must be used to adjust for the difference between FY90 dollars and base-year dollars.
APPENDIX C.

DIRECTORY STRUCTURE AND FILE REQUIREMENTS
APPENDIX C.

DIRECTORY STRUCTURE AND FILE REQUIREMENTS

DIRECTORY STRUCTURE

The ARCS directory structure was designed to satisfy a variety of hardware configurations. While it may not be obvious why some of the structure is necessary, its use is required to ensure proper operation of the ARCS models. The ARCS structure is shown in Figure C-1 at the end of the appendix.

When the ARCS is first installed, all files for the Cost Model, Age Model, Procurement Model, and New Aircraft Model are stored in the baseline subdirectory for each model. In addition, selected files for each model are placed in the working directories to ensure that the models can be executed. To conserve disk space, the working directories may be partially emptied after model runs are complete, provided that these select files are retained. These select files and their working directory assignments are as follows:

<table>
<thead>
<tr>
<th>Subdirectory</th>
<th>Select Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGE</td>
<td>AGE.XLM, AGE.XLC, SUFFIX.DEL</td>
</tr>
<tr>
<td>FORCES</td>
<td>RCM.XLM, RCM.XLC, SUFFIX.DEL</td>
</tr>
<tr>
<td>INVENTORY</td>
<td>INV.XLM, INV.XLC, CHARTS.XLM</td>
</tr>
<tr>
<td>NEW_SYS</td>
<td>NEWSYS.XLM, NEWSYS.XLC, SUFFIX.DEL</td>
</tr>
<tr>
<td>PROCUREMENT</td>
<td>PROCURE.XLM, PROCURE.XLC, SUFFIX.DEL</td>
</tr>
</tbody>
</table>
FILE REQUIREMENTS

The file requirements for the models are not yet complete. File conventions have been established to satisfy various model functions. In most cases file extensions are used to identify the file function or use. The file extension conventions established thus far, beginning with extensions common to all models, are as follows:

<table>
<thead>
<tr>
<th>Models</th>
<th>File Extension</th>
<th>File Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>.XLM</td>
<td>Excel macro sheet</td>
</tr>
<tr>
<td></td>
<td>.XLC</td>
<td>Excel chart</td>
</tr>
<tr>
<td></td>
<td>.XLS</td>
<td>Excel spreadsheet</td>
</tr>
<tr>
<td></td>
<td>.DEL</td>
<td>A list of the file extensions for the files that will be deleted when a model is started by selecting a specific case</td>
</tr>
<tr>
<td></td>
<td>.SAV</td>
<td>A list of the file extensions for the files that will be saved if a case name is provided upon exiting a model</td>
</tr>
</tbody>
</table>

---

C-2
<table>
<thead>
<tr>
<th>Model</th>
<th>File Extension</th>
<th>File Use</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>.EXE</td>
<td>Executable &quot;C&quot; program</td>
</tr>
<tr>
<td></td>
<td>.CRD</td>
<td>Note card files</td>
</tr>
<tr>
<td></td>
<td>.TXT</td>
<td>Text files created by the model</td>
</tr>
<tr>
<td>Cost</td>
<td>.FOR</td>
<td>Force files</td>
</tr>
<tr>
<td></td>
<td>.CBC/.CDC/.CRC</td>
<td>Baseline/delta/revised cost data in constant dollars</td>
</tr>
<tr>
<td></td>
<td>.FBC/.FDC/.FRC</td>
<td>Baseline/delta/revised cost data in current dollars</td>
</tr>
<tr>
<td></td>
<td>.CMI</td>
<td>Cost model input factors; includes O&amp;S and procurement factors used in calculations</td>
</tr>
<tr>
<td></td>
<td>.CMH</td>
<td>Cost model hidden files</td>
</tr>
<tr>
<td></td>
<td>.PBC/.PDC/.PRC</td>
<td>Baseline/delta/revised personnel files</td>
</tr>
<tr>
<td>Inventory</td>
<td>.NAV/.AF</td>
<td>Inventory files for Navy/Air Force aircraft</td>
</tr>
<tr>
<td></td>
<td>.NAC/.AFC</td>
<td>Note card files for the respective inventory files</td>
</tr>
</tbody>
</table>
Note: The drive designation H:\ is substituted for the actual disk drive at run time. All disk drive references in the ARCS are to the H drive.

Figure C-1. ARCS Directory Structure
APPENDIX D.

AMORD DEFENSE MISSION CATEGORY STRUCTURE
APPENDIX D.

AMORD DEFENSE MISSION CATEGORY STRUCTURE

The AMORD Defense Mission Category (DMC) structure is used extensively in the Cost Model. Forces are aggregated and displayed using the groups described by the DMCs and baseline costs are prepared using these same groups. Every program element (PE) is assigned to a unique DMC and pre-processors are used to prepare much of the data used in the models. The DMCs are listed on the following pages. For additional information concerning PE assignment to DMCs, see IDA Paper P-2290, October 1989.
<table>
<thead>
<tr>
<th>DMC</th>
<th>Mission Category Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Major Force Missions</td>
</tr>
<tr>
<td>11</td>
<td>Strategic Forces</td>
</tr>
<tr>
<td>111</td>
<td>Strategic Offense</td>
</tr>
<tr>
<td>1111</td>
<td>Bomber Forces</td>
</tr>
<tr>
<td>11111</td>
<td>Bombers</td>
</tr>
<tr>
<td>11112</td>
<td>Tankers</td>
</tr>
<tr>
<td>1112</td>
<td>ICBMs</td>
</tr>
<tr>
<td>1113</td>
<td>SLBMs</td>
</tr>
<tr>
<td>11131</td>
<td>SLBM Forces</td>
</tr>
<tr>
<td>11132</td>
<td>SLBM Base Operations &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>1114</td>
<td>Acts Supporting SAC Bombers &amp; ICBMs</td>
</tr>
<tr>
<td>11141</td>
<td>USAF Strategic Support Activities</td>
</tr>
<tr>
<td>11142</td>
<td>USAF Strat. Base Operations &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>112</td>
<td>Strategic Defense</td>
</tr>
<tr>
<td>1121</td>
<td>Space Defense</td>
</tr>
<tr>
<td>1122</td>
<td>Ballistic Missile Defense</td>
</tr>
<tr>
<td>11221</td>
<td>Ballistic Missile Defense Forces</td>
</tr>
<tr>
<td>11222</td>
<td>Missile Defense Base Ops. &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>1123</td>
<td>Interceptors</td>
</tr>
<tr>
<td>1124</td>
<td>NORAD/SPACECOM Support</td>
</tr>
<tr>
<td>11241</td>
<td>NORAD/SPACECOM Support Activities</td>
</tr>
<tr>
<td>11242</td>
<td>NORAD/SPACECOM Base Ops &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>1125</td>
<td>Surveillance</td>
</tr>
<tr>
<td>1126</td>
<td>Air Defense Initiative</td>
</tr>
<tr>
<td>113</td>
<td>Strategic C3</td>
</tr>
<tr>
<td>1131</td>
<td>Surveillance/Warning</td>
</tr>
<tr>
<td>1132</td>
<td>Command Centers</td>
</tr>
<tr>
<td>1133</td>
<td>Communications</td>
</tr>
<tr>
<td>114</td>
<td>Industrial &amp; Stock Fund Support</td>
</tr>
<tr>
<td>12</td>
<td>General Purpose Forces</td>
</tr>
<tr>
<td>121</td>
<td>Land Forces</td>
</tr>
<tr>
<td>1211</td>
<td>Army Division Increment</td>
</tr>
<tr>
<td>1212</td>
<td>Army Non-Divisional Combat Increment</td>
</tr>
<tr>
<td>1213</td>
<td>Army Tactical Support Increment</td>
</tr>
<tr>
<td>1214</td>
<td>Marine Ground Forces</td>
</tr>
<tr>
<td>12141</td>
<td>Marine Divisions</td>
</tr>
<tr>
<td>12142</td>
<td>Marine Non-Divisional Combat Increment</td>
</tr>
<tr>
<td>12143</td>
<td>Marine Tactical Support Increment</td>
</tr>
<tr>
<td>1215</td>
<td>Army Special Mission Forces</td>
</tr>
<tr>
<td>1216</td>
<td>Army Base Operations &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>1217</td>
<td>Army Operational Support</td>
</tr>
<tr>
<td>1218</td>
<td>Army R&amp;D Support</td>
</tr>
<tr>
<td>12181</td>
<td>Army Aircraft R&amp;D Programs</td>
</tr>
<tr>
<td>12182</td>
<td>Army Missile R&amp;D Programs</td>
</tr>
<tr>
<td>12183</td>
<td>Army Weapons &amp; Tracked Combat Veh. R&amp;D</td>
</tr>
<tr>
<td>12184</td>
<td>Army Ammunition R&amp;D Programs</td>
</tr>
<tr>
<td>12185</td>
<td>Army Other R&amp;D Programs</td>
</tr>
<tr>
<td>1219</td>
<td>Army Systems Support</td>
</tr>
<tr>
<td>121A</td>
<td>Marine Ground Forces Support</td>
</tr>
<tr>
<td>121A1</td>
<td>Marine Base Operations &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>121A2</td>
<td>Marine Operational Support</td>
</tr>
<tr>
<td>121A3</td>
<td>Marine R&amp;D Support</td>
</tr>
<tr>
<td>122</td>
<td>Tactical Air Forces</td>
</tr>
<tr>
<td>1221</td>
<td>Air Force</td>
</tr>
<tr>
<td>12211</td>
<td>Air-To-Air Combat</td>
</tr>
<tr>
<td>12212</td>
<td>Air-To-Ground Combat</td>
</tr>
<tr>
<td>12213</td>
<td>Defense Suppression</td>
</tr>
<tr>
<td>12214</td>
<td>Tactical Reconnaissance</td>
</tr>
<tr>
<td>12215</td>
<td>Tactical C3</td>
</tr>
<tr>
<td>12216</td>
<td>Tanker/Cargo</td>
</tr>
<tr>
<td>12217</td>
<td>Other Tactical Air Warfare</td>
</tr>
<tr>
<td>12218</td>
<td>Non-Strategic Nuclear TacAir Forces</td>
</tr>
<tr>
<td>12219</td>
<td>R&amp;D Support To Tactical Air Forces</td>
</tr>
<tr>
<td>122A</td>
<td>Operations Support TacAir Activities</td>
</tr>
<tr>
<td>1221B</td>
<td>Ops. Support Base Ops. &amp; Mgmt. HQ</td>
</tr>
<tr>
<td>1222</td>
<td>Marine</td>
</tr>
</tbody>
</table>

Note: Levels 1-5 shown, as necessary, to indicate DMC structure.
Major Force Missions

<table>
<thead>
<tr>
<th>DMC</th>
<th>Mission Category Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>12221</td>
<td>Air-To-Air Combat</td>
</tr>
<tr>
<td>12222</td>
<td>Air-to-Ground Combat</td>
</tr>
<tr>
<td>12223</td>
<td>Defense Suppression</td>
</tr>
<tr>
<td>12224</td>
<td>Tactical Reconnaissance</td>
</tr>
<tr>
<td>12225</td>
<td>Tactical C3</td>
</tr>
<tr>
<td>12226</td>
<td>Tanker/Cargo</td>
</tr>
<tr>
<td>12227</td>
<td>Other Tactical Air Warfare</td>
</tr>
<tr>
<td>12229</td>
<td>R&amp;D Support to Tactical Air Forces</td>
</tr>
<tr>
<td>1222A</td>
<td>Operations Support TacAir Activities</td>
</tr>
<tr>
<td>1223</td>
<td>Navy</td>
</tr>
<tr>
<td>12231</td>
<td>Air-To-Air Combat</td>
</tr>
<tr>
<td>12232</td>
<td>Air-to-Ground Combat</td>
</tr>
<tr>
<td>12233</td>
<td>Defense Suppression</td>
</tr>
<tr>
<td>12234</td>
<td>Tactical Reconnaissance</td>
</tr>
<tr>
<td>12235</td>
<td>Tactical C3</td>
</tr>
<tr>
<td>12237</td>
<td>Other Tactical Air Warfare</td>
</tr>
<tr>
<td>123</td>
<td>Naval Forces</td>
</tr>
<tr>
<td>1231</td>
<td>Submarines</td>
</tr>
<tr>
<td>1232</td>
<td>Surface Combatants</td>
</tr>
<tr>
<td>12321</td>
<td>Carriers</td>
</tr>
<tr>
<td>12322</td>
<td>Battleships</td>
</tr>
<tr>
<td>12323</td>
<td>Cruisers &amp; Destroyers</td>
</tr>
<tr>
<td>12324</td>
<td>Frigates, Patrol Combatants, &amp; Craft</td>
</tr>
<tr>
<td>1233</td>
<td>Amphibious Forces</td>
</tr>
<tr>
<td>1234</td>
<td>Service Forces</td>
</tr>
<tr>
<td>1235</td>
<td>Mine Warfare Forces</td>
</tr>
<tr>
<td>1236</td>
<td>Maritime Patrol &amp; Undersea Surveillance</td>
</tr>
<tr>
<td>12361</td>
<td>Maritime Patrol</td>
</tr>
<tr>
<td>12362</td>
<td>Undersea Surveillance</td>
</tr>
<tr>
<td>1237</td>
<td>Sea Based ASW Air Forces</td>
</tr>
<tr>
<td>1238</td>
<td>Non-Strategic Nuclear Naval Forces</td>
</tr>
<tr>
<td>1239</td>
<td>Fleet Support</td>
</tr>
<tr>
<td>12391</td>
<td>Fleet Support, General</td>
</tr>
<tr>
<td>12392</td>
<td>Fleet Support, Surface</td>
</tr>
<tr>
<td>12393</td>
<td>Fleet Support, Air</td>
</tr>
<tr>
<td>123A</td>
<td>Navy Systems Support</td>
</tr>
<tr>
<td>123A1</td>
<td>Navy Systems Support, General</td>
</tr>
<tr>
<td>123A2</td>
<td>Navy Systems Support, Surface</td>
</tr>
<tr>
<td>123A3</td>
<td>Navy Systems Support, Surface and Air</td>
</tr>
<tr>
<td>123A4</td>
<td>Navy Systems Support, Air</td>
</tr>
<tr>
<td>123B</td>
<td>Navy R&amp;D Support</td>
</tr>
<tr>
<td>123B1</td>
<td>Navy Surface Ship Related R&amp;D</td>
</tr>
<tr>
<td>123B2</td>
<td>Navy Aircraft Related R&amp;D</td>
</tr>
<tr>
<td>123B3</td>
<td>Navy General R&amp;D Support</td>
</tr>
<tr>
<td>123C</td>
<td>Navy Base Ops &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>123C1</td>
<td>Navy Base Ops &amp; Mgmt. HQs, General</td>
</tr>
<tr>
<td>123C2</td>
<td>Navy Base Ops &amp; Mgmt. HQs, Surface</td>
</tr>
<tr>
<td>123C3</td>
<td>Navy Base Ops &amp; Mgmt. HQs, Subsurface</td>
</tr>
<tr>
<td>123C4</td>
<td>Navy Base Ops &amp; Mgmt. HQs, Air</td>
</tr>
<tr>
<td>123C5</td>
<td>Navy Base Ops &amp; Mgmt. HQs, Projection</td>
</tr>
<tr>
<td>123D</td>
<td>Other Operational Support</td>
</tr>
<tr>
<td>123D1</td>
<td>Other Operational Support, General</td>
</tr>
<tr>
<td>123D2</td>
<td>Other Operational Support, Surface</td>
</tr>
<tr>
<td>123D3</td>
<td>Other Operational Support, Subsurface</td>
</tr>
<tr>
<td>123D4</td>
<td>Other Operational Support, Air</td>
</tr>
<tr>
<td>123D5</td>
<td>Other Operational Support, Projection</td>
</tr>
<tr>
<td>124</td>
<td>Mobility Forces</td>
</tr>
<tr>
<td>1241</td>
<td>Multimode &amp; Intermodal Lift</td>
</tr>
<tr>
<td>12411</td>
<td>Multi/Intermodal C3</td>
</tr>
<tr>
<td>12418</td>
<td>Multi/Intermodal BOS &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>1242</td>
<td>Airlift Forces</td>
</tr>
<tr>
<td>12421</td>
<td>Airlift C3</td>
</tr>
<tr>
<td>12423</td>
<td>Military Intertheater Airlift</td>
</tr>
<tr>
<td>12424</td>
<td>Aeromedical Airlift</td>
</tr>
<tr>
<td>12425</td>
<td>Commercial Airlift</td>
</tr>
<tr>
<td>12426</td>
<td>Military Intratheater Airlift</td>
</tr>
</tbody>
</table>

Note: Levels 1-5 shown, as necessary, to indicate DMC structure.
<table>
<thead>
<tr>
<th>DMC</th>
<th>Mission Category Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>12427</td>
<td>Airlift Rescue &amp; Recovery</td>
</tr>
<tr>
<td>12428</td>
<td>Airlift Base Operations &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>12429</td>
<td>Airlift Operational Support</td>
</tr>
<tr>
<td>1242A</td>
<td>Airlift Revenues</td>
</tr>
<tr>
<td>1243</td>
<td>Sealift Forces</td>
</tr>
<tr>
<td>12431</td>
<td>Sealift C3</td>
</tr>
<tr>
<td>12432</td>
<td>Sea Based Prepositioning</td>
</tr>
<tr>
<td>12433</td>
<td>Military Intertheater Sealift</td>
</tr>
<tr>
<td>12435</td>
<td>Commercial Sealift</td>
</tr>
<tr>
<td>12438</td>
<td>Sealift Base Operations &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>1243A</td>
<td>Sealift Revenues</td>
</tr>
<tr>
<td>1244</td>
<td>Land Mobility Forces</td>
</tr>
<tr>
<td>12441</td>
<td>Land Mobility C3</td>
</tr>
<tr>
<td>12442</td>
<td>Land Based Prepositioning</td>
</tr>
<tr>
<td>12443</td>
<td>Military Intra-theater Land Mobility</td>
</tr>
<tr>
<td>12448</td>
<td>Land Mobility BOS &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>12449</td>
<td>Land Mobility Operational Support</td>
</tr>
<tr>
<td>1244A</td>
<td>Land Mobility Revenues</td>
</tr>
<tr>
<td>125</td>
<td>Special Operations Forces</td>
</tr>
<tr>
<td>1251</td>
<td>SOF Operations</td>
</tr>
<tr>
<td>1252</td>
<td>SOF Support Activities</td>
</tr>
<tr>
<td>12521</td>
<td>SOF Training</td>
</tr>
<tr>
<td>12522</td>
<td>SOF General Support</td>
</tr>
<tr>
<td>12523</td>
<td>SOF Force Enhancements</td>
</tr>
<tr>
<td>12524</td>
<td>Advanced Special Operations RD&amp;A</td>
</tr>
<tr>
<td>12525</td>
<td>SOF Management HQs</td>
</tr>
<tr>
<td>126</td>
<td>General Purpose Support</td>
</tr>
</tbody>
</table>

Note: Levels 1-5 shown, as necessary, to indicate DMC structure.
## Defense-Wide Missions

<table>
<thead>
<tr>
<th>DMC</th>
<th>Mission Category Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Defense-Wide Missions</td>
</tr>
<tr>
<td>21</td>
<td>Intelligence &amp; Communications</td>
</tr>
<tr>
<td>211</td>
<td>Intelligence</td>
</tr>
<tr>
<td>2111</td>
<td>National Foreign Intelligence Program</td>
</tr>
<tr>
<td>21111</td>
<td>Foreign Intelligence Program Activities</td>
</tr>
<tr>
<td>21112</td>
<td>Intelligence BOS &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>2112</td>
<td>Other Intelligence Activities</td>
</tr>
<tr>
<td>2113</td>
<td>Central-Intelligence &amp; Investigative</td>
</tr>
<tr>
<td>21131</td>
<td>Central-Intel &amp; Investigative Activities</td>
</tr>
<tr>
<td>21132</td>
<td>Central-Intelligence Mgmt HQs</td>
</tr>
<tr>
<td>212</td>
<td>Communications</td>
</tr>
<tr>
<td>2121</td>
<td>Centrally Managed Communications</td>
</tr>
<tr>
<td>21211</td>
<td>Centrally Managed Comm. Activities</td>
</tr>
<tr>
<td>21212</td>
<td>Communications BOS &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>2122</td>
<td>Command &amp; Control Activities</td>
</tr>
<tr>
<td>22</td>
<td>General Research &amp; Development</td>
</tr>
<tr>
<td>221</td>
<td>Science &amp; Technology Program</td>
</tr>
<tr>
<td>2211</td>
<td>Technology Base</td>
</tr>
<tr>
<td>22111</td>
<td>Research (6.1)</td>
</tr>
<tr>
<td>22112</td>
<td>Exploratory Development (6.2)</td>
</tr>
<tr>
<td>2212</td>
<td>Advanced Technology Development (6.3A)</td>
</tr>
<tr>
<td>222</td>
<td>Undistributed Development Programs</td>
</tr>
<tr>
<td>2221</td>
<td>Undistributed Advanced Development</td>
</tr>
<tr>
<td>2222</td>
<td>Undistributed Engineering Development</td>
</tr>
<tr>
<td>223</td>
<td>RDT&amp;E Management &amp; Support</td>
</tr>
<tr>
<td>2231</td>
<td>R&amp;D Support Activities</td>
</tr>
<tr>
<td>2232</td>
<td>R&amp;D BOS &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>23</td>
<td>Other Defense-Wide Missions</td>
</tr>
<tr>
<td>231</td>
<td>Geophysical Sciences</td>
</tr>
<tr>
<td>2311</td>
<td>Geophysical Activities</td>
</tr>
<tr>
<td>2312</td>
<td>Geophysical BOS &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>232</td>
<td>Space Launch Support</td>
</tr>
<tr>
<td>233</td>
<td>Nuclear Weapons Support</td>
</tr>
<tr>
<td>234</td>
<td>International Support</td>
</tr>
</tbody>
</table>

**Note:** Levels 1-5 shown, as necessary, to indicate DMC structure.
Defense-Wide Support Missions

<table>
<thead>
<tr>
<th>DMC</th>
<th>Mission Category Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Defense-Wide Support Missions</td>
</tr>
<tr>
<td>31</td>
<td>Logistics Support</td>
</tr>
<tr>
<td>311</td>
<td>Supply Operations</td>
</tr>
<tr>
<td>312</td>
<td>Maintenance Operations</td>
</tr>
<tr>
<td>313</td>
<td>Other Logistics Support</td>
</tr>
<tr>
<td>3131</td>
<td>Logistics Support to R&amp;D Activities</td>
</tr>
<tr>
<td>3132</td>
<td>Logistics Support to Procurement Acts</td>
</tr>
<tr>
<td>3133</td>
<td>Logistics Support to MILCON Activities</td>
</tr>
<tr>
<td>3134</td>
<td>Logistics BOS &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>3135</td>
<td>Other Logistics Support</td>
</tr>
<tr>
<td>32</td>
<td>Personnel Support</td>
</tr>
<tr>
<td>321</td>
<td>Personnel Acquisition</td>
</tr>
<tr>
<td>3211</td>
<td>Personnel Acquisition</td>
</tr>
<tr>
<td>3212</td>
<td>Personnel Acquisition Base Operations</td>
</tr>
<tr>
<td>322</td>
<td>Training</td>
</tr>
<tr>
<td>3221</td>
<td>Military Personnel Training</td>
</tr>
<tr>
<td>3222</td>
<td>Civilian Personnel Training</td>
</tr>
<tr>
<td>3223</td>
<td>Flight Training</td>
</tr>
<tr>
<td>3224</td>
<td>Intelligence Skill Training</td>
</tr>
<tr>
<td>3225</td>
<td>Health Personnel Training</td>
</tr>
<tr>
<td>3226</td>
<td>Training BOS &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>323</td>
<td>Medical</td>
</tr>
<tr>
<td>3231</td>
<td>Hospitals &amp; Other Medical Activities</td>
</tr>
<tr>
<td>3232</td>
<td>Medical BOS &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>324</td>
<td>Individuals</td>
</tr>
<tr>
<td>325</td>
<td>Federal Agency Support</td>
</tr>
<tr>
<td>326</td>
<td>Other Personnel Support</td>
</tr>
<tr>
<td>3261</td>
<td>Family Housing</td>
</tr>
<tr>
<td>3262</td>
<td>Dependent Education</td>
</tr>
<tr>
<td>3263</td>
<td>Other Personnel Support Activity</td>
</tr>
<tr>
<td>3264</td>
<td>Personnel BOS &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>33</td>
<td>Other Centralized Support</td>
</tr>
<tr>
<td>331</td>
<td>Departmental Headquarters</td>
</tr>
<tr>
<td>3311</td>
<td>Departmental Headquarters</td>
</tr>
<tr>
<td>3312</td>
<td>Departmental HQs BOS &amp; Mgmt. HQs</td>
</tr>
<tr>
<td>332</td>
<td>Retired Pay</td>
</tr>
<tr>
<td>333</td>
<td>Undistributed Adjustments</td>
</tr>
</tbody>
</table>

Note: Levels 1-5 shown, as necessary, to indicate DMC structure.
APPENDIX E.

"GET," "SAVE," AND "PURGE" UTILITY PROGRAMS
APPENDIX E.

"GET," "SAVE," AND "PURGE" UTILITY PROGRAMS

Several utility programs, written in the "C" programming language, perform key tasks in the ARCS. These utilities are used by the Cost Model, Age Model, Procurement Model, and New Aircraft Model. The Inventory Model performs similar functions directly from the model menu. Three of these utility programs, Get, Save, and Purge, are described in the following subsections.

THE GET PROGRAM

The Get program (GET.EXE) is a "C" Windows application that is called from the Excel macro sheet of each model. The purpose of the program is to load the necessary files into the model's working directory to perform the desired analysis. After the model is selected, the GET program displays a dialog box (Figure 16) that prompts the user to choose either the baseline case or another case that was created and saved in previous runs of the model. The GET dialog box contains a list box of case names and four buttons that allow the user to select one of the following four actions:

- "Get highlighted case" - The cursor position is used to determine the highlighted case. The cursor may be positioned to the desired case using either the mouse or the keyboard. When this option is selected, files created by previous runs of the model are deleted from the working directory and the files from the selected case are copied into the working directory. Files that will be deleted from the working directory are identified in the file named SUFFIX.DEL, which contains a list of file extensions. All files with these extensions will be deleted from the working directory. The Get program then compares the files remaining in the working directory with the files in the selected case directory and copies all necessary files into the working directory. The date and time of each file are compared to preclude copying files into the working directory that are already there.
- "Use previous case" - Select this option to instruct the program to accept all files as they exist in the working directory. *No files will be copied.* This choice allows you to continue from the last position calculated by the model.

- "Delete highlighted case" - This option allows you to delete a case that was previously saved.

- "Cancel" - Select this option to cancel the model selection that you made and return you to the ARCS Main Menu.

**THE SAVE PROGRAM**

The Save program (SAVE.EXE) provides the capability to save the results of specific model exercises. This "C" Windows program is called from each model's macro sheet. When called, a dialog box (Figure 21) appears on the screen that displays the names of previously saved cases and a text box for entering the name of a new case. Selecting the name of an existing case followed by choosing either the "Save - Exit" or "Save - No Exit" buttons will cause the current exercise in the working directory to be saved to the case name selected. The specific files saved are determined by file name extensions identified in a file named SUFFIX.SAV. Each file's date and time stamp is checked to preclude unnecessary copying. The "No Save - No Exit" and the "No Save - Exit" buttons in the dialog box cancel the save request.

One final action occurs when a case is saved. When the case name is identified, a file is written containing that name. Subsequent use of the saved case will make the case name a permanent part of any printed output. This tagging of the printed output links the printed results to the case name for future reference.

**THE PURGE PROGRAM**

The Purge program (PURGE.EXE) provides the capability to "purge" the working directories in order to release disk space for other activities. Purge is called from the ARCS Main Menu and provides the options to delete all files in the working directory of each model or to selectively delete files, one at a time. A separate file, KEEP.ME, located in the baseline directory of each model, contains the file names that will be re-copied from the baseline directory into the working directory to ensure that the model re-starts properly after a purge operation has.
been performed. The menu choices provided when the Purge program is initiated are self-explanatory.
APPENDIX F.

WINDOWS TECHNIQUES
APPENDIX F.

WINDOWS TECHNIQUES

This appendix provides a primer on the general use of Windows applications, particularly those essential for using the ARCS. It is not a replacement for the documentation provided with Microsoft Windows or Microsoft Excel.

The ARCS is a collection of computer models written using Microsoft Windows, Microsoft Excel, and the "C" programming language. Use of the Windows environment facilitates many of the functions associated with the models' normal operations, such as viewing multiple tables or charts, editing input files, or printing output tables.

Use of the Windows and Excel software also provides significant advantages in that choices can be made in the models in a manner consistent with the methods used when Windows and Excel are used for other purposes. For example, pull-down menus display all options available at a given time.

GENERAL WINDOWS DEFINITIONS

A basic understanding of Windows-based terminology is necessary to use Windows applications efficiently. There are primarily three ways to perform operations or to access information in the Windows environment: (1) using the mouse to point and click, (2) using direct access keys and direction keys from the keyboard, or (3) using accelerator keys from the keyboard. An overview of working in the Windows environment both from the keyboard and with a mouse is presented here; however, the use of a mouse is strongly recommended.

Most Windows applications appear within the standard visual interface. The components of this interface are shown in Figure F-1.
The functions of the components are explained below:

- **Control Menu Box** - a small horizontal bar in the top left corner of a window; used with a mouse to access the Control Menu, which allows window manipulation.

- **Title Bar** - shows the name of the application in the window.

- **Minimize Box** - a down arrow in the top right corner of a window; minimizes the current window to an icon when clicked on with a mouse. *(Not recommended when using the ARCS.)*

- **Maximize Box** - an up arrow in the top right corner of a window; maximizes the current window to full screen display when clicked on with a mouse. *(Not recommended when using the ARCS.)*

- **Menu Bar** - shows the options available in an application. Each option on the menu bar provides access to a pull-down menu with additional options. The underlined letter in each option is called the direct access key.

- **Scroll Bar** - allows horizontal and vertical movement in lists or files with large amounts of information when clicked on with a mouse.

- **Scroll Box** - allows rapid horizontal and vertical movement in a list or file when dragged with a mouse.
Keyboard Basics

The most frequently used keyboard convention in Windows applications is the ALT key in combination with other keys. The "other keys" fall into one of three categories:

- **Direct access keys** - the underlined letter in menu options
- **Direction keys** - the four arrow keys (up, down, left, or right)
- **Accelerator keys** - key sequences that are programmed for special functions; these vary with each application.

In most instances pressing the ESC (Escape) key cancels or stops a procedure.

Mouse Basics

The use of a mouse simplifies operation of the ARCS models and is strongly recommended when working with any Windows applications. A mouse provides much easier access to window manipulations, menus and their options, and even data entry. When using a mouse, you will see a pointer on the screen that is controlled by moving the mouse on a flat surface. When using a multiple-button mouse, use the left button for Windows applications.

Most Windows functions are performed by "pointing and clicking," that is, moving the mouse until the pointer is directed at the desired item and pressing the left mouse button, or by pointing and "double clicking," that is, pressing the left mouse button twice in rapid succession. Some Windows functions are performed by "dragging," that is, pointing and then holding down the mouse button until an action is completed. An example of this action is selecting or highlighting data for some other operation. To cancel or stop a procedure, either press the ESC (Escape) key or point and click in a blank area of the window.

MANIPULATING WINDOWS

When working in the Windows environment, it is important to be able to move both within a window and between windows. Instructions for both keyboard and mouse techniques are given here.
Keyboard Manipulation

Many functions have more than one way of being accessed or activated from the keyboard. Below are the keyboard commands for using some of the components of the Windows interface that were shown in Figure F-1.

Opening the Control Menu: Most window manipulations performed at the keyboard are accessed through the Control Menu, which is selected by pressing:

ALT+SPACEBAR.

After the Control Menu is opened, a pull-down menu appears with a number of options. An option can be selected in one of three ways, as described in the next subsection.

Selecting an Option From the Control Menu: Three methods of selecting an option from the Control Menu are available: (1) by use of the appropriate direct access key (the underlined letter in the option name), (2) by moving the cursor to the appropriate option using the direction keys, thus highlighting the option, and pressing ENTER, and (3) by use of the accelerator keys (the key sequences listed to the right of the Control Menu options). The options in the pull-down menu, their functions, and each of the three methods available to access them are described below.

- **Restore** restores the current window to its previous size. To select this option, type one of the following sequences:
  - ALT+SPACEBAR+R
  - ALT+SPACEBAR+ENTER
  - ALT+F5

- **Move** allows you to move the current window to a new screen location. To select this option, type one of the following sequences:
  - ALT+SPACEBAR+M
  - ALT+SPACEBAR+DOWN ARROW+ENTER

Once one of these actions has been taken, a four-headed arrow appears in the window. Use the direction keys to move the window to the desired location and press ENTER.
• **Size** allows you to change the size of the current window. To select this option, type one of the following sequences:
  - ALT+SPACEBAR+S
  - ALT+SPACEBAR+DOWN ARROW twice+ENTER

  Once one of these actions has been taken, a four-headed arrow appears in the window. Use the direction keys to move the arrow to select the border to be moved. Continue pressing the arrow keys to move the border until the desired window size is reached, then press ENTER.

• **Minimize** reduces the current window to the size of an icon. To select this option, type one of the following sequences:
  - ALT+SPACEBAR+N
  - ALT+SPACEBAR+DOWN ARROW three times+ENTER
  - ALT+F9

• **Maximize** enlarges the current window to a full screen display. To select this option, type one of the following sequences:
  - ALT+SPACEBAR+X
  - ALT+SPACEBAR+DOWN ARROW four times+ENTER
  - ALT+F10

• **Close** closes the current window and terminates the application. To select this option, type one of the following sequences:
  - ALT+SPACEBAR+C
  - ALT+SPACEBAR+DOWN ARROW five times+ENTER
  - ALT+F4

  **Scrolling:** To scroll through an open file, use the direction keys (UP ARROW, DOWN ARROW, LEFT ARROW, and RIGHT ARROW) by repeatedly pressing the key that points in the direction scrolling is desired.

  **Selecting an Item From the Menu Bar:** Two ways are available for selecting an item from the menu bar, as follows:
  • ALT+Direct Access Key
  • ALT+Direction Key (LEFT ARROW or DOWN ARROW)+ENTER
Once either of these key sequences is completed the pull-down menu for the item selected appears. Some options in the menu may be "grayed," which means they are not available at this point in the execution of the application. Choose an option by pressing the direct access key for that option, or by using the direction keys (UP ARROW or DOWN ARROW) to highlight the appropriate option and pressing ENTER.

Figure F-2 shows the menu bar for Microsoft Excel with the File pull-down menu open. Keyboard commands for the more common Excel functions are explained below.

![Figure F-2. Microsoft Excel Menu Bar](image)

**Saving a File:** To save a file using this application, use one of the following sequences:

- ALT+F+S
- ALT+RIGHT ARROW+DOWN ARROW three times+ENTER

**Moving Between Windows:** When more than one window is open, you can move from one window to another by use of one of the following sequences:

- ALT+ESC
- ALT+TAB
Mouse Manipulation

This section explains how to manipulate windows in Excel using a mouse. All of the keyboard techniques just explained can be used whether a mouse is used or not. However, a mouse allows for quicker, easier methods for obtaining the same results.

Opening the Control Menu: Point and click on the Control Menu Box. The pull-down menu will open, showing the same options as described in the section on keyboard manipulation.

Selecting an Option From the Control Menu: Explanations of how to select an option by use of the mouse are given below:

- **Restore** - point and click on the box that contains both an up arrow and a down arrow in the top right-hand corner of the window.
- **Move** - point to the title bar of the window and drag it to the new screen location.
- **Size** - point to a border or corner of the window to be sized and drag the two-headed arrow that appears until the desired window size is reached.
- **Minimize** - point and click on the down arrow in the top right-hand corner of the window.
- **Maximize** - point and click on the up arrow in the box in the top right-hand corner that has two arrows in it.
- **Close** - point and click on the first menu option in the menu bar and click on the Exit command or point and click on the Exit option on the menu bar.

Scrolling:

- To scroll one line at a time, point and click on the arrow in the scroll bar of the desired scrolling direction;
- To scroll one screen at a time, point and click on the scroll bar on either side of the scroll box;
- To scroll quickly, drag the scroll box in the appropriate scroll bar to the general location desired (i.e., middle, end) of the list or file.

Selecting an Item From the Menu Bar: point and click on the desired option. This provides access to the chosen option’s pull-down menu. Some options in pull-
down menus may be "grayed," which means they are not available at this point in the execution of the application. Choose an option by pointing and clicking on the desired option.

**Moving Between Windows:** When multiple windows are open, point and click on the window that is to come to the forefront of the screen.

**DIALOG BOXES AND LISTS**

Frequently in Windows applications, after choosing an option from a pull-down menu or at specific times in the execution of an application, a dialog box will appear. A dialog box is used either to give messages or to ask for further information. The content and placement of dialog boxes vary with each application. A dialog box can consist of one or more of the components described below.

**List Box:** Provides a list of choices to select from. The boxes under "Files" and "Directories" in Figure F-3 are list boxes. Lists can be scrolled by using the scroll bar to the right of the box.

![Figure F-3. Typical Dialog Box Display](image)

**Text Box:** Allows information to be typed directly from the keyboard; sometimes a text box can be used to input information instead of choosing from a list box. The box to the right of "File Name:" in Figure F-3 is a text box.
Command Buttons: Carry out the indicated commands when chosen. The "OK" and "Cancel" buttons in Figure F-3 are command buttons.

Check Box: A check mark ("x") in a check box indicates an active option. Check boxes allow multiple choices for a given option. Each check box is an individual area in a dialog box. "Line Wrap," "Local Echo," and "Sound" in Figure F-4 are check boxes.

Option Buttons: A dot in an option button indicates an active option. Only one option button can be chosen for a given option and the entire option, rather than each button, is an individual area in a dialog box. The "Columns" and "Cursor" areas contain option buttons in Figure F-4.

Using the Keyboard with Dialog Boxes

When working with dialog boxes, it is important to be able to move between areas in the dialog box and to know how to select items in the different types of areas.

Moving Between Dialog Box Areas:
- ALT+Direct Access Key
- TAB key to move from area to area.
Selecting Items in a List Box: Use the Direction keys to move the cursor to the desired item and press the SPACEBAR to select the item.

Entering Items in Text Box: Often a default value for a choice will appear in a text box. Press ENTER to accept this response. If another choice is desired, type the input information from the keyboard and press ENTER.

Selecting Check Boxes: TAB to each desired box and press the SPACEBAR to either place or remove a check mark.

Choosing an Item from a Group of Option Buttons: Use the Direction keys to move to and choose the desired item. Only one button in each group may be chosen.

Choosing a Command Button: Press ENTER when the desired command button is highlighted.

Canceling a Dialog Box: Press ESC.

Using the Mouse with Dialog Boxes

When working with dialog boxes, it is important to be able to move between areas in the dialog box and to know how to select items in the different types of areas.

Moving Between Dialog Box Areas: Point and click on the desired area.

Selecting Items in a List Box: Point and click on the desired item.

Entering Items in Text Box: Type the input information from the keyboard. Often a default value for a choice will appear in a text box. Press ENTER to accept this response and leave the dialog box or simply continue moving to other areas of the dialog box without changing this information.

Selecting Check Boxes: Point and click in the desired check box to either place or remove a check mark.

Choosing an Item from a Group of Option Buttons: Point and click on the desired option button. Only one button may be chosen.

Choosing a Command Button: Point and click on the desired command button.
Canceling a Dialog Box: Press ESC.

Although this section has given separate instructions for the keyboard and the mouse, many users of Windows applications choose to use a combination of keyboard and mouse techniques, depending on the application and the functions desired. For more information regarding these and other Windows techniques, refer to your Windows and Excel manuals.
## ABBREVIATIONS

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/C</td>
<td>aircraft</td>
</tr>
<tr>
<td>AMORD</td>
<td>Advanced Mission-Oriented Resources Display</td>
</tr>
<tr>
<td>ARCS</td>
<td>Aviation Requirements Cost System</td>
</tr>
<tr>
<td>ASCII</td>
<td>American Standard Code for Information Interchange</td>
</tr>
<tr>
<td>BY$</td>
<td>Budget Year dollars</td>
</tr>
<tr>
<td>CER</td>
<td>cost estimating relationship</td>
</tr>
<tr>
<td>DMC</td>
<td>Defense Mission Category</td>
</tr>
<tr>
<td>DoD</td>
<td>Department of Defense</td>
</tr>
<tr>
<td>DOS</td>
<td>Disk Operating System</td>
</tr>
<tr>
<td>EGA</td>
<td>Enhanced Graphics Adapter</td>
</tr>
<tr>
<td>EW</td>
<td>electronic warfare</td>
</tr>
<tr>
<td>FSD</td>
<td>Full Scale Development</td>
</tr>
<tr>
<td>FY</td>
<td>fiscal year</td>
</tr>
<tr>
<td>FYDP</td>
<td>Future-Years Defense Program</td>
</tr>
<tr>
<td>G&amp;A</td>
<td>general and administrative</td>
</tr>
<tr>
<td>GUI</td>
<td>graphical user interface</td>
</tr>
<tr>
<td>IDA</td>
<td>Institute for Defense Analyses</td>
</tr>
<tr>
<td>MB</td>
<td>megabytes</td>
</tr>
<tr>
<td>MFP</td>
<td>Major Force Program</td>
</tr>
<tr>
<td>MILCON</td>
<td>military construction</td>
</tr>
<tr>
<td>MILPERS</td>
<td>military personnel</td>
</tr>
<tr>
<td>MRS</td>
<td>modification, replenishment spares, and support equipment and facilities</td>
</tr>
</tbody>
</table>

Abb-1
O&M operations and maintenance
O&S operating and support
OASD(PA&E) Office of the Assistant Secretary of Defense (Program Analysis and Evaluation)
ODDR&E(TWP) Office of the Director, Defense Research and Engineering (Tactical Warfare Programs)
PA Procurement Annex
PAA Primary Authorized Aircraft
PC personal computer
PE Program Element
PGSE peculiar ground support equipment
PSE peculiar support equipment
R&D research and development
RDT&E research, development, test, and evaluation
RIC Resource Identification Code
TAAI total active aircraft inventory
TI Technology Index
TOE Tables of Equipment
USAF United States Air Force
VAMOSC Visibility and Management of Operating and Support Costs
VGA Video Graphics Adapter

Abb-2